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Introduction 

This course will explain the calculation of steel following the EN 1993-1-1: General rules and rules for buildings and EN 

1993-1-2: Design of Steel Structures: Structural fire design. 

Most of the options in the course can be calculated/checked in SCIA Engineer with the Concept edition (sen.ed.co.en). 

For some supplementary checks an extra module (or edition) is required, but this will always be indicated in those 

paragraphs. 

Below you can find an image of the workspace of SCIA Engineer and where to find the different menus. 
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Chapter 1: Materials 

For standard steel grades, the yield strength fy and tensile strength fu are defined according to the thickness of the 

element. 

The standard steel grades as defined in Table 3.1 of the EN 1993-1-1 are:  
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Those materials are included in SCIA Engineer. You can find them via Menu bar > Libraries > Materials 

The Histar and Fritenar steel grades have been implemented according to Arcelor. 

Also materials from the product codes are implemented in the software (for example materials from Belgian National 

Annex NBN NA,…). 

With the option ‘Thickness range’ the influence of the thickness on the yield strength fy and tensile strength fu are 

defined. When inputting a new user defined material in SCIA Engineer, also the thickness range for that material should 

be inputted: 

  

 

Example: NA_Material_Strength_Application.esa 

In this example a material of the National Annex of Belgium has been inputted manually: S 275 J2. 

This material has a lot of thickness range strength reductions, as we can see in the thickness range table: 
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And for each beam the correct yield strength has been taken into account according to the inputted table above. You 

can check this by performing a linear calculation and asking for the detailed output for Menu bar > Design > Steel 

members > ULS Check (or Process toolbar > Steel > Steel ULS check) : 

CS1 CS2 CS3 CS4 
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Chapter 2: Cross-sections and classification 

 Cross-sections 

SCIA Engineer will use the axes y-y and z-z respectively for the major and minor principal axes of the cross-section. 

If the principal axes not coincide with the y-y and z-z axes following the EN 1993-1-1, also those axes are indicated: 

EN 1993-1-1 SCIA Engineer EN 1993-1-1 SCIA Engineer 

 

  

 

 

  

 

 

 

 

 

 

 

 

 

  

 

In the steel code check, the strong axis will always be considered as the y-y axis. So, when inputting a profile in which 

the local y-axis does not corresponds with the strong axis, the axes are switched in the steel code check and SCIA 

Engineer will give a message about the axes. 
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Be aware that the switch will also affect the buckling settings for yy and zz. 

 

You can avoid this behaviour by creating the cross-section differently, so the y-axis remains the strong axis. Afterwards 

with the properties of the member you can perform a rotation of the local coordinate system (LCS rotation) if 

necessary. 

 

Example: Local Axes.esa 

The strong axis of this cross-section in the local z-axis: 

 

This beam is only loaded by a line load in the z-direction, resulting in a moment My and a shear force Vz on the beam. 

When looking at the steel code check, the axes are switched and the strong axis is taken as local y-axis: 

 

This is indicated in steel code check and also the internal forces are switched following the new local axis. 
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 Section classification 

Since SCIA Engineer 17.0, all sections containing an initial shape can be classified. The sections without an initial shape 

cannot be classified and will be automatically checked as being class 3.  

When you use a cross-section from the profile library, the initial shape will be available. When you want to use another 

cross-section, you can use the group ‘Thin-walled geometric’, for which the initial shape and torsion properties are 

available. 

 

Example: Cross-section.esa 

• 3 cross-sections: 

o HE300A from profile library 

o HE300A inputted as a general cross-section (imported from .dwg) 

o HE300A inputted as a sheet welded Iw section. By creating this section, it is important that the correct 

value for parameter a is defined in mm. This parameter will be recognized as the fixed part in the 

calculation of the initial shape: 

 
 

 
• Only the first and the third profile are recognized as a symmetric I-shape containing an initial shape. For this 

reason, the classification calculation can be performed. 

• The second profile is not recognized as a symmetric I-shape and there is no initial shape available.  

• The first and the third profile will be classified as an I-profile and a plastic check will be performed.  

• The second profile cannot be classified, so an elastic check will be performed. This will result in different 

checks: 
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Note: the general cross-section cannot be imported in SCIA Engineer with the concept edition. For this functionality, the 

Professional or Expert edition is necessary (or module sen.05). 

 

 

SCIA Engineer will calculate the classification automatically, but the calculated classification in SCIA Engineer can be 

overruled by 2 settings in the steel member data (Input panel > Steel > Steel member data or Process toolbar > Steel 

member data): 

 

• Section classification: you can choose between a classification calculation ‘By program’, or can overwrite this 

and choose for class 1, 2 or 3. Since classification 4 is not described for all cross-sections in the Eurocode, this 

option cannot be chosen. 

• Elastic Check Only: you can choose to perform only an elastic check. This corresponds with a class 3 check. 
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The classification of cross-sections is executed according to EN 1993-1-1, art. 5.5. 

Four classes of cross-sections are defined: 

• Class 1 (EC3, NEN) or PL-PL (DIN) section 

Cross-sections which can form a plastic hinge with the rotation capacity required for plastic analysis 

• Class 2 (EC3, NEN) or EL-PL (DIN) section 

Cross-sections which can develop their plastic moment resistance, but have limited rotation capacity 

• Class 3 (EC3, NEN) or EL-EL (DIN) section 

Cross-sections in which the calculated stress in the extreme compression fibre of the steel member can reach 

its yield strength, but local buckling is liable to prevent development of the plastic moment resistance 

• Class 4 (EC3, NEN) or slender section 

Cross-sections in which it is necessary to make explicit allowance for the effects of local buckling when 

determining their moment resistance or compression resistance 

 

 

 

 

 

This classification depends on the proportions of each of its compression elements. 

For each intermediary section, the classification is determined and the related section check is performed. The 

classification can change for each intermediary point.  

For each load case/combination, the critical section classification over the member is used to perform the stability 

check. So, the stability section classification can change for each load case/combination. 

However, for non-prismatic sections, the stability section classification is determined for each intermediary section. 

The classification check in SCIA Engineer will be executed following tables 5.2 of the EN 1993-1-1. 

For standard sections, the classification is done according to the parts of the Initial Shape. 

• Internal compression elements (I) are classified according to Table 5.2 Sheet 1. 

• Outstand compression elements (SO & UO) are classified according to Table 5.2 Sheet 2. 

• CHS (Circular Hollow Sections) are classified according to Table 5.2 Sheet 3. 

• Angle sections are classified according to Table 5.2 Sheet 2 and in case of uniform compression also Sheet 3. 

Note: cross-sections without an initial shape are classified as elastic class 3. 
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As mentioned before, since SCIA Engineer 17.0, a new classification tool is used based on the initial shape of the cross-

section.  

You can choose between 3 methods to determine the plastic stress distribution in the cross-section: 

• Elastic stresses; 

• Yield surface intersection; 

• Iterative approach. 

In the cross-section properties, you can choose the plastic analysis method. However, this is only informative and this 

choice is not decisive. The method that will be used to perform the steel code check can be chosen in the steel setup 

window (Menu bar > Design > Steel members > Settings or Process toolbar > Steel > Steel settings): 
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 Elastic stresses 

The elastic stresses method is a fast approach using fixed formulas. In this method, the plastic stress distribution is 

based on the elastic stresses f1 and f2 at the ends of the parts. 

Standard calculation of α 

In case one stress is positive (compression) and the other stress is negative (tension), the following calculation is used: 

α � �σ����	
����
��σ����	
����
� � |σ�

���
| 
In all other cases α is taken as 1,00 for the given part. 

Double-symmetric I-section 

Specially for a double-symmetric I-section, the α-value of the web element is overruled by the following formula (Ref. 

[36]): 

 

Within this formula, NEd is taken as positive for compression and as negative for tension. 

Below you can find the output for cross-section HE450A: 
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 Yield surface intersection 

For this method, a full plastic analysis is performed. This plastic analysis is based on the initial shape and uses a stress-

strain diagram with yielding plateau. 

 

The yield surface is generated for the given section and the intersection of the actual forces is determined with this 

surface.  

The actual intersection point (grey) does not always collide with a predetermined point of the surface, so small 

deviations can occur. From the location of the plastic neutral axis, which results of this analysis, the α-value for the 

different parts can be determined. 

 

Note: it can happen that the plastic neutral axis is rotated, but this has a negligible effect on α. This happens when the 

closest point on the yield surface has a minor Mz moment. 
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 Iterative approach 

Also for this method, a full plastic analysis is performed. This plastic analysis is based on the initial shape and uses a 

stress-strain diagram with yielding plateau. 

The actual plane of deformation for the given internal forces is determined iteratively, which provides an exact solution.  

 

 

  



Chapter 2: Cross-sections and classification 

BV – 2024/12/31  21 

 Semi-Comp+ 

Another development that has been available since SCIA Engineer 17.0, is the classification of semi-compact steel 

sections. Semi-compact steel sections are sections which are classified as class 3. 

The Semi-Comp+ option can be activated in the steel setup: 

 

The use of this option has a dual application: 

• classification limits are modified for I-sections and RHS sections; 

• interpolated section modulus between the elastic and plastic values. 

Adaption classification limits 

Currently, there is a discrepancy in the used classification limits between EN1993-1-1 and EN1993-1-5. The Semi-Comp+ 

publication identified this discrepancy and proposed new classification limits (Ref. [36]):  

 

Note: these adaptions on the classification limits will be implemented in the next iteration of EN1993-1-1. 
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Interpolated section modulus 

The section moduli will be interpolated between the elastic and plastic values. This results in the advantage that the 

plastic capacity of the section is considered for class 3 sections. 
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 Effective section 

If the classification results in a class 4 profile, the effective cross-section will be calculated according to EN 1993-1-5. 

For each load case and combination, the most critical effective area properties are saved: 

• Aeff is the effective area of the cross-section when subject to uniform compression; 

• Weff is the effective section modulus of the cross-section when subject only to moment about the 

relevant axis; 

• eN is the shift of the relevant centroidal axis when the cross-section is subject to uniform compression. 

With these critical properties, the steel code check will be executed. 

 

Example: Industrial Hall.esa 

In this example the classification will be done for an IPE750x134 profile, resulting in a class 4 cross-section. And 

afterwards the calculation of the effective shape following EN 1993-1-5 will be given. 

We consider column B28: 

 

The classification has been executed at the bottom of the column (position = 0,00 m) 

On this position a hinged support has been inputted, so on this position the column is not subjected to bending. 
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With table 5.2 of EN 1993-1-1 we can determine the class for each component of the cross-section. 

Web according to table 5.2 (sheet 1): 

 

c = H – 2 * thickness flange – 2 * radius 

c = 753 mm – 2*17 mm – 2*17 mm = 685 mm 

t = 13,20 mm 

c/t = 51,89 

 

With ε � �235/fy � 1 

Maximum ratio for class 1: 33 

Maximum ratio for class 2: 38 

Maximum ratio for class 3: 42 

 c/t = 51,89 > 42  Class 4 

Flange according to table 5.2 (sheet 2): 

 

c = B/2 – (thickness web)/2 – radius 

c = 265 mm/2 – 13,20 mm/2 – 17 = 108,9 mm 

t = 17 mm 

c/t = 6,40 

 

With ε � �235/fy � 1 

Maximum ratio for class 1: 9 

Maximum ratio for class 2: 10 

Maximum ratio for class 3: 14 

 c/t = 6,40 < 9  Class 1 

 

This corresponds with the classification of this cross-section for the stability check in SCIA Engineer: 
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This cross-section has a classification class 4 for the stability classification, so effective properties must be calculated. 

Those properties are also given in SCIA Engineer in the preview of the steel code check, just below the classification 

calculation. 

 

The calculation of the sectional area Aeff is given below. 

In this section there is a uniform compression force over the web. 

The calculation of the effective section will be performed following EN 1993-1-5:2006, Tabel 4.1 and EN 1993-1-

5:2006/AC:2009 article 9). In Table 4.1 the uniform compression situation will be used in this example: 

 

For ψ = 1 and internal compression elements: 

λ���� � 0,5 � �0,085  0,055ψ � 0,673 → ρ � 1 

λ���� & 0,5 � �0,085  0,055ψ � 0,673 → ρ � ' λ����  0,22)/ λ����*
 

For our cross-section: 

λ���� � +f,/σ�	-..0 � b�/t28,4 ∙ ε ∙ �k6 � 51,8928,4 ∙ 1,00 ∙ √4,0 � 0,91 

With: 

• ε = 1,00 (S235) 

• kσ = 4,0 (table 4.1 of EN 1993-1-5:2006) 

So: 

ρ �  0,91  0,22 '0,91)* �  0,83 
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b
9 � b
* �  0,5 ∙ b
:: � 0,5 ∙ ρ ∙ b� � 0,5 ∙ 0,83 ∙ 685 mm �  284,62 mm 

A
:: � +265 ∙ 17 � 284,62 ∙ 13,20 � 17 ∙ 13,20- ∙ 2 �  16972,77 mm² 

 

In this calculation the roundings at the corners between the flanges and the web are not taken into account. Therefore 

the result in SCIA Engineer will be a bit higher: 

 

Also the other properties of this effective cross-section can be calculated. 

Note: for cold-formed cross-sections the rules are adapted (according to EN 1993-1-3). 
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Chapter 3: Shear center eccentricity 

Definition shear centre: the point at which a load applied parallel to the plane of the section will produce no torsion. For 

doubly symmetric profiles this is always the center of gravity, but for non-symmetrical profiles this is not the case. 

 

When a shear is applied to a non-symmetrical section, there will be opposite stresses in the section to counter this 

force and these will continue in the flanges. When it’s symmetrical these flanges will lift each other up but here both of 

them will create forces which will create an additional torsional moment. This torsional moment can be countered by 

applying the load with an eccentricity, which is called the shear center eccentricity. 
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Since SCIA Engineer 22.0 the shear center eccentricity is considered in the analysis. In older versions the additional 

torsion isn’t considered in the analysis since the force was placed in the center of gravity. When opening a project 

created in an older version, the advanced solver option ‘Neglect shear center eccentricity’ is activated and you can 

deactivate it to take the effect into account in the analysis. 

 

Below you can find a small example of the effect, left with the shear center eccentricity taken into account and right 

without the effect: 

 

If wanted, you can neglect the effect for a specific cross-section by editing the torsion properties for the cross-section: 

 

Note that in SCIA Engineer only 6 degrees of freedom are available, so only St. Venant torsion can be considered in the 

analysis. It is possible to consider warping in the steel code check. Further explanation on this is given in the torsion 

check in chapter 4. 
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Chapter 4: ULS section check 

In this chapter, first the partial safety factors are explained and afterwards a short explanation of all the section checks 

is given. 

The section check can be found in SCIA Engineer under Menu bar > Design > Steel members > ULS Check or Process 

toolbar > Steel > Steel ULS check. In the properties of the check, you can choose to look at the Brief, Summary or 

Detailed output: 

• with the brief output the results are shown in one line; 

• with the summary output, the results of all unity checks are shown on one page; 

• with the detailed output, the results of all the unity checks are shown including a reference to the used 

formula in the EN 1993-1-1 for each check. Since SCIA18.0 also all formulas can be shown in the output. 

Further in this chapter, the section checks will be explained and the detailed results are shown. 

 Partial safety factors 

The partial safety factors are taken from EN 1993-1-1 art. 6.1. 

Following safety factors are considered: 

• γM0 = 1,00: resistance of cross-sections; 

• γM1 = 1,00: resistance of members to instability accessed by member checks; 

• γM2 = 1,25: resistance of cross-sections in tension to fracture. 

 

Those factors can also be found in the National Annex of EN 1993-1-1 in SCIA Engineer (via Status bar > National annex 

> Manage annexes): 
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 Tension 

The tension check will be executed following EN 1993-1-1 art. 6.2.3 formula (6.5): N?@N�,A@ � 1 

With: 

• N�,A@ � B∙:CDEF the design plastic resistance of the cross-section 

 

Example: Industrial Hall.esa 

Consider bracing B234 (for load case 3DWind1). In this load case the bracing is under tension: 
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 Compression 

The compression check will be executed following EN 1993-1-1 art. 6.2.4 formula (6.9): N?@N�,A@ � 1 

With: 

• N�,A@ � B∙:CDEF for class 1, 2 or 3 cross-sections 

• N�,A@ � BGHH∙:CDEF  for class 4 cross-sections 

 

Example: Industrial Hall.esa 

Consider column B28 (for combination CO1-ULS).  

 

The classification on this position is Class 1 (column under compression and bending). 
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 Bending moment 

The bending moment check for My and Mz will be executed following EN 1993-1-1 art. 6.2.5 formula (6.12): M?@M�,A@ � 1 

With: 

• M�,A@ � M�J,A@ � KLM∙:CDEF  for class 1 or 2 cross-sections 

• M�,A@ � M
J,A@ � KGM,NOP∙:CDEF  for class 3 cross-sections 

• M�,A@ � KGHH∙:CDEF   for class 4 cross-sections 

Note: an interpolated section modulus can be used in case of class 3 cross-sections when the Semi-Comp+ method is 

activated (see chapter 2) 

 

Example: Industrial Hall.esa 

Consider column B28 (for combination CO1-ULS).  

 

The classification on this position is Class 1 (column under compression and bending). 
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 Shear 

The shear check for Vy and Vz will be executed following EN 1993-1-1 art. 6.2.6 formula (6.17): V?@V�,A@ � 1 

For plastic design Vc,Rd (in the absence of torsion) is the design plastic shear resistance Vpl,Rd, according to formula 

(6.18): 

V�J,A@ � AR ∙ Sf,/√3TγV.  

With: 

• Av  shear area, the formula for Av depends on the cross-section (see EN 1993-1-1  

article 6.2.6(3) and several ECCS publications, see annex A). 

 

For elastic design Vc,Rd is the design elastic shear resistance. The following criterion for a critical point of the cross-

section may be used (formula (6.19)) unless the buckling verification in section 5 of EN 1993-1-5 applies: τ?@f, ∙ S√3 ∙ γV.T � 1 

With (formula (6.20)):  

τ?@ �  V?@ ∙ SI�  

Where the shear force is combined with a torsional moment, the plastic resistance Vpl,Rd should be reduced as specified 

in the next paragraph. 
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Example: Industrial Hall.esa 

Consider column B28 (for combination CO1-ULS).  

 

The classification on this position is class 1 (column under compression and bending).  

 

 

 

 Torsion 

The torsion check will be executed following EN 1993-1-1 article 6.2.7 formula (6.23): T?@TA@ � 1 

Where TRd is the design torsional resistance of the cross-section. 

The total torsional moment TEd should be considered as the sum of two internal effects (formula (6.24)):  T?@ � T�,?@ � T[,?@ 

With: 

• Tt,Ed the internal St. Venant torsion 

• Tw,Ed the internal warping torsion 
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SCIA Engineer will take into account the St. Venant torsion automatically. If you would like to calculate also with 

warping torsion, you should activate this option within the System lengths and buckling settings of this member: 

 

When the check box Warping check is activated, you should indicate for the beginning and for end of the beam if the 

end is Fixed or Free for warping (you can activate the local axis on the element to see what the beginning and the end 

of the element are). 

 

Example: Warping.esa 

As quoted in the EN 1993-1-1, art. 6.2.7(7), for closed hollow sections the effects of torsional warping can be neglected 

and in the case of a member with an open cross-section, such as I of H, it may be assumed that the effects of St.Venant 

torsion can be neglected. This article is a simplification and is valid for SCIA Engineer version up to and until SCIA 

Engineer 16.1.  

Since SCIA Engineer 17.0, the warping check will also be performed for closed hollow sections, even though the fact 

that this will not have the same influence as for open profiles.  

In this example 4 beams are inputted: 

• IPE180 – no warping has been activated 

• SHS180/180/10.0 – no warping has been activated 

• IPE180 – warping has been activated in the buckling data 

• SHS180/180/10.0 – warping has been activated in the buckling data 
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On all beams, a line force of -4 kN is inputted with an eccentricity ey of 0,050 m. The k factor has been changed into 

2,00 within the buckling data for each buckling group (BC1 and BC2) since we are considering cantilevers. 

 

 

For the SHS profiles, there is a small difference between the option ‘warping’ activated or not. This was expected as 

warping is not important for closed hollow sections. 

For IPE profiles, the warping torsion cannot be neglected. So when this is activated, it has a big influence on the 

resistance value for torsion. 

Torsion check IPE180 without warping activated: 
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Torsion check IPE180 with warping activated: 

 

 

As stated before, since SCIA Engineer 17.0 the same warping check will be executed for the closed SHS profile. 
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 Combined check: bending, shear and axial force 

This check will be executed following EN 1993-1-1 articles 6.2.8, 6.2.9 & 6.2.10. 

For bi-axial bending the following criterion may be used according to formula (6.41): 

\ M,,?@M],,,A@^_ � \ M`,?@M],`,A@^a � 1 

in which  and  are defined as follows: 

• I and H sections: α = 2; β = 5n but β ≥ 1 

• Circular hollow sections: α = 2; β = 2 

• Rectangular hollow sections: α �  β � 9,cc9d9,9e
² but α = β ≤ 6 

with n � ]gh]LM,ih 

In case of one of the following, the influence of the shear force on the bending resistance cannot be accounted for using 

the specified article: 

• No plastic shear resistance is available because an elastic shear check was done, which means the 

reduction factor ρ cannot be determined. 

• Due to extreme shear the reduction factor ρ > 1 which would lead to a negative reduction. 

• In case there is no corresponding bending moment the reduction for shear cannot be applied (for 

example Vz combined with Mz and thus no corresponding My). 

In each of those cases an elastic verification using the yield criterion according to art. 6.2.1(5) (formula (6.1)) will be done 

instead. 

The values MN,y,Rd and MN,z,Rd depend on the moment resistance, reduced with a factor depending on “n”, the check of 

the normal force (formulas (6.39) and (6.40)): M],,,A@ � M�J,,,A@'1  n)/'1  0,5a[) 

M],`,A@ � M�J,`,A@'1  n)/'1  0,5a:) 

And Mpl,Rd depends on the yield strength fy. 

 

If klm n o, p kqr,s,tm: the yield strength will be reduced with a factor ρ according to formula (6.29): '1  ρ) ∙ f, 

Where: 

ρ � u2 V?@V�J,A@  1v*
 

and: 

V�J,A@ � AR ∙ Sf,/√3TγV.  

When torsion is present should be obtained from: 

ρ � u 2 V?@V�J,w,A@  1v*
 

 

Class 3 cross-sections (EN 1993-1-1 article 6.2.9.2): 

In absence of a shear force, for class 3 cross-sections the maximum longitudinal stress should satisfy the criterion 

according to formula (6.42): 

σx,?@ � f,γV. 
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Class 4 cross-sections (EN 1993-1-1 article 6.2.9.3): 

In absence of a shear force, for class 4 cross-sections the maximum longitudinal stress should satisfy the criterion 

according to formula (6.43): 

σx,?@ � f,γV. 

The following criterion according to formula (6.44) should be met: N?@
A
:: ∙ f,γV.

� M,,?@ � N?@ ∙ e],
W
::,,,��
 ∙ f,γV.

� M`,?@ � N?@ ∙ e]`
W
::,`,��
 ∙ f,γV.

� 1 

With: 

• Aeff effective area of the cross-section when subjected to uniform compression 

• Weff, min effective section modulus of the cross-section when subjected only to moment  

about the relevant axis 

• eN  shift of the relevant centroidal axis when the cross-section is subjected to  

compression only. 
 

Example: Industrial hall.esa 

Consider column B28 (for combination CO1-ULS).  

 

Unity check (or NEd/Nc,Rd) = 0.04, so n = 0,04 

 

 

The unity check for shear force is smaller than 0,5, thus there is no reduction of the yield strength for the combined 

check.  
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Chapter 5: ULS stability check 

 

The stability check can be found in SCIA Engineer under Menu bar > Design > Steel members > ULS Check or Process 

toolbar > Steel > Steel ULS check. In the properties of the check, you can choose to look at the Brief, Summary or 

Detailed output, as explained in the previous chapter. 

In below the stability check will be explained and the detailed results are shown. 

 Classification 

The classification can be different for the section check and for the stability check. 

Classification in the section check: the classification is done for each section on the member and afterwards the section 

check will be executed with the classification and the internal forces on this section. 

For the classification in the stability check there are two approaches possible:  

• Maximum class along the member 

• Utilisation factor η (eta) (since SCIA Engineer 21.0) 

You can define the stability classification method in the steel settings: 

 

 Maximum class along the member 

For each load case/combination, the classification for member buckling design is determined as the maximum class along 

the member. This class is used to perform the stability check since stability effects are related to the whole member and 

not to a single cross-section. 

To determine this critical classification, all sections in the Ly and Lz system lengths of the buckling system are checked 

and the worst classification is used as the critical. Note that only sections on the actual member are used so in case the 

system length spans multiple members, only the sections of the actual member are used to determine the critical 

classification. 

For non-prismatic sections, the stability section classification is determined for each intermediary section. 
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 Utilisation factor η 

The utilisation factor η is in essence a value that reflects how much the section is utilized. The stability classification is 

taken as the section classification at the section with the maximum utilisation factor η. This is also called as the 

equivalent section class for member buckling design. 

Notes: 

• This approach leads to a more economic design of steel structures as the stability classification is based 

on the section with the highest utilisation in contrary to the previous approach which conservatively 

takes the worst classification along the member. 

• This implementation has been verified with benchmarks based on all the worked examples provided by 

Ref.[36] on p. 141-193. With one minor remark in which worked example 7 of Ref.[40] contains wrong 

values for η due to mixing up steel grades (S355 & S235) between the classification and individual checks. 

• Generating the steel code check with utilisation factor instead of max. class along member can take more 

time, especially in case the determination of the utilisation factor requires an iterative approach. 

Utilisation factor calculation via direct formulas: 

The utilisation factor η can be derived via direct formulas in certain use cases. 

• Only single section checks are used: 

Basically if the only section checks are single section checks such as single bending and/or compression, 

meaning no combined section checks are present. In such cases the utilisation factor η can be 

determined as follows depending which single section check has the highest unity check: 

o maximum section check is coming from the compression check η � UC]d 

o maximum section check is coming from the bending My check η � UCVC  

o maximum section check is coming from the bending Mz check η � UCV~  

• Certain linear combined section checks are used: 

o linear summation (eq. 6.2 of EN1993-1-1): 

η � u|N?@|NA@ � �M,,?@�M�,,,A@ � �M`,?@�M�,`,A@v 

o maximum longitudinal stress in case of class 3 (eq. 6.42 of EN1993-1-1) 

η � γV.f, ∙ '1  ρ��x) ∙ u N?@A
:: � M,,?@ ∙ zI, � M`,?@ ∙ yI` v 

o maximum longitudinal stress in case of class 4 (eq. 6.43 of EN1993-1-1) 

η � γV.f, ∙ '1  ρ��x) ∙ u|N?@|A
:: � �M,,?@�W
::,, � �M`,?@�W
::,` v 

o linear effective summation in case of class 4 (eq. 6.44 of EN1993-1-1) 

η � γV.f, ∙ '1  ρ��x) ∙ �|N?@|A
:: � �M,,?@� � |N?@| ∙ e]CW
::,,,��
 � �M`,?@� � |N?@| ∙ e]~W
::,`,��
 � 

Utilisation factor calculation via an iterative approach: 

An iterative approach is used for more complicated combined section checks in which a direct formula cannot be 

derived. 

The iterative approach increases a set of internal forces (N, MyEd, MzEd) simultaneously in small steps until the point is 

reached where one of the section checks reaches a unity check of 1. The increase of internal forces happens by means 

of dividing the set of internal forces (N, MyEd, MzEd) with the same utilisation factor η. 
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Example: Industrial hall.esa 

Consider column B28 (for combination CO1-ULS). When we have a look at the section class, we can see that a part of 

the column is classified as class 1, a part as class 3 and a part as class 4. 

 

When we use Maximum class along the member as stability classification method, the worst section class (class 4) is 

taken as the stability class. This leads to an overall unity check of 0.95 

  

We can calculate more economic by taking the stability classification method as Utilisation factor η in the steel settings. 

The decisive position for the stability classification is now based on the utilisation factor. The decisive position for 

stability classification is at 6.9 m (at the top of the column) and the decisive utilisation factor is 0.59. This leads to a 

stability class 1 and a more economic unity check of 0.86 

  

 



Chapter 5: ULS stability check 

BV – 2024/12/31  43 

 Flexural buckling 

The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.1 formula (6.46): N?@N�,A@ � 1 

Nb,Rd is calculated with a reduction factor χ, which is depending on the buckling factor k. Since this buckling factor is 

playing an important role in this calculation, we will start with explaining this factor and we will focus on the flexural 

buckling check itself further in this chapter. 

 Buckling factors 

In SCIA Engineer the calculation of the buckling coefficient ky or kz can be done automatically or you can set it manually. 

Since SCIA Engineer 18.0 a new dialog is introduced for applying buckling settings on a specific buckling system called 

System lengths and buckling settings. Prior to SCIA Engineer 18.0 there was a dialog for the buckling settings called 

‘Buckling and relative lengths’ which offered similar settings but without the graphical window and even without the 

results. 

General method 

The buckling coefficients ky and kz are, by default, automatically calculated by SCIA on the base of two approximate 

formulas respectively for sway and non-sway structures. These formulas produce buckling coefficients which are, 

respectively, larger (sway) and smaller (non-sway) than 1. 

 

So it is important for this method that you choose the correct option sway or non-sway for the two local directions: 

• y-y: buckling around the local y-axis (so deformation in the direction of the local z-axis) 

• z-z: buckling around the local z-axis (so deformation in the direction of the local y-axis) 
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The option sway or non-sway can be chosen for the whole structure in the steel settings: 

 

This can also be changed for each element separately, by using the system lengths and buckling settings. This can be 

found for each element via Property panel > Buckling > System lengths and buckling settings > Settings > Span settings. 

These properties can be inputted in the graphical window as well. 

 

For Sway y-y and Sway z-z there are 4 options: 

• From setup: the same option will be taken as in the steel setup as shown above; 

• All sway: sets all spans of the axis system as sway; 

• All non-sway: sets all spans of the axis system as non-sway; 

• Custom: allows editing the sway settings per span. 
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The following formulas are used for the buckling ratios: 

• for a non-sway structure (k ≤ 1): 1L � k � 'ρ9ρ* � 5ρ9 � 5ρ* � 24)'ρ9ρ* � 4ρ9 � 4ρ* � 12)2'2ρ9ρ* � 11ρ9 � 5ρ* � 24)'2ρ9ρ* � 5ρ9 � 11ρ* � 24) 

• for a sway (flexible) structure (k > 1): 1L � k � x� π²ρ9x � 4 

With: 

• x � �������²����'�����)������ 

• ρ� � �O�?�  

• k  buckling factor 

• L  system length 

• E  modulus of Young 

• I  moment of inertia 

• C� � VO�O  stiffness in node i 

• Mi  moment in node i 

• φi  rotation in node i 

The values for Mi and φi are approximately determined by the internal forces and the deformations, calculated by load 

cases which generate deformation forms, having an affinity with the buckling form. So when performing a linear 

calculation, in the background 2 additional load cases are calculated, just to calculated the buckling factors for the 

elements. 

This calculation is automatically done when calculating the construction linearly. So when calculating nonlinear, you 

should also perform a linear calculation otherwise no buckling factors are calculated and no steel code check can be 

performed. 

The following load cases are considered in the linear calculation for the calculation of the buckling factors: 

• load case 1:  

o local distributed loads qy=1 N/m and qz=-100 N/m on the beams 

o global distributed loads Qx =10000 N/m and Qy =10000 N/m on the columns 

• load case 2:  

o local distributed loads qy=-1 N/m and qz=-100 N/m on the beams 

o global distributed loads Qx =-10000 N/m and Qy=-10000 N/m on the columns 

The used approach gives good results for frame structures with perpendicular rigid or semi-rigid beam connections. For 

other cases, you must evaluate the presented bucking ratios. 

The concept of sway or non-sway structure is directly linked to the critical coefficient αcr issue of the stability analysis 

(see for reference the ECCS 119): 

• When αcr ≥ 10, the structure is non-sway, therefore the buckling coefficients will be smaller than 1; 

• When αcr < 10, the structure is sway, therefore the buckling coefficients will be larger than 1. 
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Hence, you should perform a stability analysis prior to setup the sway / non-sway parameter. In that way you can 

optimise better the buckling coefficients ky and kz than only with the linear analysis. 

• If αcr ≥ 10, you can simply perform a linear analysis specifying, in the steel settings window, the non-

sway behaviour of the structure for the y-y and z-z directions. Then the non-sway formula will be used to 

compute the buckling coefficients for all members. 

 
• In case αcr <10, you can choose to perform a linear analysis using sway buckling factors (which are 

always larger than 1). This method results in a much simpler analysis with respect to a second order 

analysis accounting for global and local imperfections. However, you should carefully check that this 

possibility is allowed in the used design norm (for instance, the Belgian national annex of Eurocode 

currently does not allow this method, thus requiring a second order analysis). Also, note that this 

method is more conservative with respect to a second order calculation accounting for global and local 

imperfections. 

Note: sway and non-sway is not the same as unbraced and braced: 

• If Ψbr > 0,2 Ψunbr: the frame is unbraced; 

• If Ψbr ≤ 0,2 Ψunbr: the frame is braced. 

Ψbr is the lateral flexibility of the structure with bracing system. 
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As said before, the formulas used for the computation of ky and kz are valid only in case of rigid and/or semi-rigid frame 

structures. This limitation implies that the ky and kz values automatically computed by SCIA should be critically checked 

when the application case is different from the one specified above. In such cases you have several possibilities: 

• Limitation of the calculated value for ky and kz, to be set in the steel settings window: 

 
• Manual input of the buckling coefficient or buckling length, to be set in the System lengths and buckling 

settings window: 
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• Numerical computation of the buckling coefficient via a stability analysis.  

In this last case, a stability analysis should be performed, and the instability mode of the element for 

which the ky and kz are looked for should be retrieved. Once this has been done, these stability modes 

can be affected to the element via Input panel > Steel > Stability member data or Process toolbar > Steel 

> Stability member data: 

  

 

Example: Buckling Factor.esa 

Consider column B1: 

• L = 4000mm 

• Set as sway 

• In node N1: My = 0 kNm  C2 = ρ2 = 0 

• This node N1 defines ρ2 because ρ2 is always the smallest of the two. 

• In node N2 for load case LC1: 

o My1 = 79883 kNm 

o φ1 = φ_y = 1523,3 mrad 

o C1 = My1/φ1 = 79883 kNm / 1523,3 mrad = 52,44 kNm/mrad = 5,244 x 1010 Nmm/rad 

o E = 210000 N/mm² 

o Iy = 162700000 mm4 

o ρ9 � �O�?� �  0,*��∙�F�F�NN��h ∙�...��
*9.... �NN�∙9c*�..... ��� � 6,139 

o x � ������������'�����)������ � �∙c,9e�∙.���∙c,9e���'c,9e��.)��∙c,9e�∙. � 1,0 

o k � x� ��
��x � 4 � 1,0� ��

c,ec�∙9,.. � 4 � 2,368 

o N�	 � �²?��²�² � �²∙*9....]/��²∙9c*�..... ���
'*,ec�)�'�...)² � 3758575 N � 3759 kN 

Those values can also be found in SCIA Engineer: via Menu bar > Design > Steel members > Slenderness or Process 

toolbar > Steel > Steel slenderness the buckling length ky will be found: 
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This value can also be found in the stability check through Menu bar > Design > Steel members > ULS Check or Process 

toolbar > Steel > Steel ULS check under the buckling parameters. And here also the critical normal force Ncr can be 

found: 

 

 

Calculation of buckling factors for crossing diagonals 

As the previous default method is only valid for perpendicular connections, this method cannot be used for the 

calculation of the buckling factors for diagonals. 

In the DIN 1880 Teil 2, Table 15 a method is given for the calculation of the buckling factor for crossing diagonals. In 

SCIA Engineer this option is also implemented. In this method the buckling length sK is calculated in function of the load 

distribution in the element and sK is not a purely geometrical data.  

This method is only applicable for 2 diagonals with a hinged or rigid connection in the middle. To use this functionality 

in SCIA Engineer, you must connect the two diagonals with the option Input panel > Structure > Boundary conditions > 

Crosslink: 

 

When connecting two beams with this option, in the System lengths and buckling settings window of the two elements 

you should set Crossing diagonals as special buckling system type (this option can be found under Advanced settings): 
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If this option is used, SCIA Engineer will use the method from EN1993-2 to calculate the buckling factors for the 

diagonals: 

 

With:  

• β  buckling length factor 

• L  member length 

• l1  length of supporting diagonal 

• I  moment of inertia (in the buckling plane) of the member 

• I1  moment of inertia (in the buckling plane) of the supporting diagonal 

• N  compression force in member 

• N1  compression force in supporting diagonal 

• Z  tension force in supporting diagonal 

• E  modules of Young (elastic modulus) 
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Calculation of the buckling length for a VARH element 

For a VARH element, SCIA Engineer will use another calculation for the buckling length. 

A VARH element is defined as follows: the member has the properties of a symmetric I section where only the height is 

linear variable along the member. The system length for buckling around the local y-y axis (strong axis), is equal to the 

member length. 

For a VARH element we can define 

• ky  buckling coefficient around the y-y-axis 

• Ly  system length around the y-y-axis 

• Iy,max maximum moment of inertia around the y-axis 

• Iy,min minimum moment of inertia around the y-axis 

• Iy,eq equivalent moment of inertia around the y-axis 

• E  modules of Young (elastic modulus) 

• Ncr,y critical Euler force around the y-axis 

 

Hirt and Crisinel (Ref. [17]) presents expressions for the elastic critical load of axially loaded non-prismatic members of 

double symmetric cross-sections. Flexural buckling around the strong axis of the cross-sections occurs for:  

N�	,, � π² ∙ E ∙ I,,
�Sk, ∙ L,T*  

Where: I,,
� � C ∙ I,,��x 

And C is a coefficient that depends on the parameter r, defined as the ratio between the minimum and the maximum 

moments of inertia. 

r � �I,,��
I,,��x 

For a tapered member, C can be calculated as: c � 0,08 � 0,92 ∙ r 

 

Example: VARH.esa 

 

Consider column B1: the VARH element going from 800 mm to 300 mm 
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The VARH is internally divided into a number of prismatic members. In this case, in 5 parts, but this can be changed in 

the Mesh setup window (Menu bar > Tools > Calculation & mesh > Mesh settings) : 

 I,,��
 � 1,7041 ∙ 10�mm� 

I,,��x � 1,6989 ∙ 10�mm� 

r � �I,,��
I,,��x � �1,7041 ∙ 10�mm�1,6989 ∙ 10�mm� � 0,316711 

C � 0,08 � 0,92 ∗ r � 0,3713 I,,
� � C ∗ I,,��x � 0,3713 ∗ 1,6989e� � 6,3093 ∙ 10�mm� 

N�	,, � π* ∗ E ∗ I,,
�k,* ∗ L,* � 4503,61 kN 
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 Buckling length 

In the previous paragraph the general calculation of the buckling factors has been explained for all type of elements. 

With this buckling factor the buckling length of the beam will be calculated as follows: l � k ∙ L 

With: 

• l  buckling length 

• k  buckling factor 

• L  system length 

The system length of an element is defined by the property ‘System lengths and buckling settings’ of the element. It is 

the distance between the buckling supports. 

The buckling length can be calculated with the buckling factor (which can be calculated automatically or manually 

inputted) or it can be given manually. 

 

Example: Buckling Length.esa 

Consider column B3. This column has 3 nodes: N5, N10 and N6. The local x direction goes from the bottom to the top of 

the column, so internal for SCIA Engineer N5 is the first node of this column and N6 the last one. 

In the property panel for this column, you can choose for System lengths and buckling settings. With this option, the 

system length of the beam can be inputted. By default the following option will appear: 
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Explanation of the system lengths: 

• The first node (according to the local x-axis) is node N5, the last one is node N6. 

• y-y direction: 

o This means around the local y-axis. So the column will deform in the z-direction. 

o Around the y-axis, node N5 is supported. In node N10 no beam can be found in the local z-

direction in this point, thus column B3 is not supported around the y-axis in node N10. In node 

N6 a horizontal beam in the local z-direction can be found and the column will be supported 

around the local y-axis (y-y) in node N6. This is indicated with the triangles in this window: 

 Supported in node N5 

 Not supported in node N10 

 Supported in node N6 

• z-z direction: 

o This means around the local z-axis. So the column will deform in the y-direction. 

o Around the z-axis, node N5 is supported. In node N10 a horizontal beam in the local y-direction 

can be found and the column will be supported around the local z-axis (z-z) in node N10. Also in 

node N6 a horizontal beam in the local y-direction can be found and the column will also be 

supported around the local z-axis (z-z) in node N6. This is indicated with the triangles in this 

window: 

 Supported in node N5 

 Supported in node N10 

 Supported in node N6 

• The system length will be taken as follows: 

o Around the y-axis: the length between node N5 and N6: so 3 m 

o Around the z-axis: the length between node N5 and N10 for the first part of the column (1,8 m) 

and the length between N10 and N6 for the second part of the column (1,2 m) 

o This can also be found via Menu bar > Design > Steel members > Slenderness or Process toolbar 

> Steel > Steel slenderness: 

 
In this window you can easily check the system length (Ly and Lz), the buckling factors (ky and 

kz) and the buckling length (ly = ky x Ly and lz = kz x Lz). 

 

As mentioned before, since SCIA Engineer 18.0 a new dialog is introduced for applying buckling settings on a specific 

buckling system called System lengths and buckling settings.  

System lengths and buckling settings can be accessed either: 

• via Menu bar > Libraries > Structure and analysis > Buckling groups and click on <New> for creating a 

new buckling group or click on <Edit> to modify an existing buckling group. 

• via the properties of a 1D-member: Property panel > System lengths and buckling settings. 
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The left part of the dialog gives you a graphical representation of the 1D-members in the buckling system with their 

buckling constraints and information about the sway settings per span. It is not only a representation of the above 

mentioned settings, but it also allows editing directly in that graphical window by clicking on the buckling constraints to 

set them to fixed/free or by clicking on the sway symbols per span to set them to From setup, All sway, All non-sway or 

Custom. By clicking on the triangles indicating the system lengths of each part of a beam, you can change the buckling 

constraints.  

For the buckling constraints there are two symbol types depending on the chosen span: 

• Triangle symbol (buckling span y-y, z-z and for the deflection spans deflection y, deflection z) 

• Rectangular symbol (buckling span y-z, LTB (Lateral Torsional Buckling)) 

Besides this, with this new improved buckling settings, it is easier to access the results. You can see them by clicking on 

the Results tab of the system lengths and buckling settings window.  

 



Advanced Concept Training – Steel code check 

56  BV – 2024/12/31 

Compare column B3 and column ‘B2+B30’ with each other: they should have exactly the same system length. The only 

difference between those columns is that element B3 was inputted as a beam of 3 m and column ‘B2+B30’ is divided in 

two parts. SCIA Engineer will consider those two beams also as one buckling system: 

• When the local axes are exactly in the same direction (so in this case the local x-axis is in the same 

direction and the angle between the beams is exactly 180°). 

• If no hinge has been inputted between the two beams. 

Now look at beam B13. The system lengths are the following (as expected, because there are horizontal beams in the 

two directions on each node): 

 

When looking at the rendered view, it will be clear that beam B16 is too weak to have an influence on the system length 

of beam B13. In SCIA Engineer there is possibility to exclude a beam from a buckling system.  

Select beam B16 and go to ‘Buckling’ in its properties window. It is possible to indicate that beam B16 is a secondary 

beam and should not be considered in the system lengths:  
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When looking now at member B13 and changing the System lengths and buckling settings back to Default, the member 

B16 will not be included in the system lengths: 

    

 

 Flexural buckling check 

The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.1 formula (6.46): N?@N�,A@ � 1 

Where: 

• N�,A@ � £∙B∙:CDE�  for class 1, 2 or 3 cross-sections 

• N�,A@ � £∙BGHH∙:CDE�  for class 4 cross-sections 

The reduction factor χ will be calculated as follows: 

χ � 9¥��¥²d¦§� but < 1,0 

With: 

• Φ � 0,5 ©1 � αSλ�  0,2T � λ�*ª 

• λ� � �B∙:C]«�    for class 1, 2 or 3 cross-sections 

λ� � �BGHH∙:C]«�  for class 4 cross-sections 

• N�	 � �²?��²�² critical normal force (Euler force) 

• α   imperfection factor depending on the buckling curve: 

 

The selection of the buckling curve for a cross-section is done with EN 1993-1-1, Table 6.2 
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Example: Buckling Curves.esa 

In Table 6.2 general buckling curves are given for the most common profiles. For some cross-section types, SCIA 

Engineer will automatically use these curves. The cross-section groups that are supported are: 

• Profile library; 

• Haunch; 

• Sheet welded; 

• Build-in beams; 

• Thin-walled geometric; 

• Fabricated. 

For the other cross-section groups, the buckling curves for both directions are by default set to ‘d’. This can be changed 

manually by changing the properties of the cross-section. 

In this example 2 beams are inputted with 2 different cross-sections: 

• B1: CS1 – IPE180 

o buckling curve a for y-y according to code 

o stability check uses curve a, according to code 

• B2: CS2 – I form (Geometric shapes group) 

o non-standard cross-section: no buckling curve according to code. Buckling curve d is used. 

o stability check uses curve d 
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Once all the buckling factors and system lengths have been inputted correctly, the flexural buckling check can be 

executed in SCIA Engineer. 

 

Example: Industrial hall.esa 

Consider column B28. SCIA Engineer will first show the buckling parameters of this beam: 

 

In below the results of the yy direction are explained. 

This direction has been set on sway in the steel setup and with this option the buckling factor k is calculated.  

The length of the column is 6,900 m, so the buckling length = 3,58 x 6,900 m = 24,716 m 

With this buckling length the critical Euler load Ncr can be calculated. Afterwards the slenderness and the relative 

slenderness can be calculated with the critical Euler load. 

An IPE750 profile has a buckling curve a, resulting in an imperfection factor α = 0,21. 

With those properties the reduction factor χ will be calculated, which will be used in the following formula: 

 

This result in a buckling resistance Nb,Rd = 3284,63 kN for flexural buckling around the local y-axis. 

The same principle can be repeated for flexural buckling around the local z-axis. 

This will result in a lower buckling resistance: Nb,Rd = 2111,87 kN. 

The lowest buckling resistance will be used in the flexural buckling check: 
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 Torsional buckling 

The check on torsional buckling can be important for profiles in which the position of the shear centre is not the same 

as the centre of gravity of this section. 

The torsional (-flexural) buckling check is executed according to EN 1993-1-1, art 6.3.1.4. In case of an RHS section or 

CHS section the check will not be executed and a note will be shown instead. In case of an I-section, when the check is 

not limiting it will not be printed and a note is shown instead. Not limiting is defined here as a unity check lower than 

the unity check for Flexural Buckling. In case however Flexural buckling can be ignored (due to low compression force or 

low slenderness) the comparison is done with the unity check of the compression check. The buckling curve for 

torsional (-flexural) buckling is taken as the z-z buckling curve. The value of the elastic critical load Ncr is taken as the 

smallest of Ncr,T (Torsional buckling) and Ncr,TF (Torsional-Flexural buckling). For doubly symmetric sections the elastic 

critical load Ncr is taken equal to Ncr,T. 

The elastic critical load Ncr,T for torsional buckling is calculated as Ref.[37]: 

N�	,w � 1i.* uGI� � π*EI[I�* v 

i.* � i,* � i*̀ � y.* � z.* 

i.*SN  N�	,,TSN  N�	,`TSN  N�	,wT  N*y.*SN  N�	,`T  N*z.*SN  N�	,,T � 0 

With 

• G  shear modulus 

• E  modulus of elasticity 

• iy  radius of gyration about the strong axis 

• iz  radius of gyration about weak axis 

• It  torsion constant 

• Iw  warping constant 

• IT  buckling length for the torsional buckling mode 

• y0 and z0 coordinates of the shear centre with respect to the centroid 

• Ncr,y critical axial load for flexural buckling around the y-y axis 

• Ncr,z critical axial load for flexural buckling around the y-y axis 

• Ncr,T critical axial load for torsional buckling 
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Example: Flexural Torsional buckling.esa 

Look at the steel code check for member B1: 

 

 

 

  



Chapter 5: ULS stability check 

BV – 2024/12/31  63 

 Lateral torsional buckling 

 Calculation of Mcr 

General formula 

The elastic critical moment for lateral torsional buckling Mcr is calculated by the following formula: 

M�	 � C9 π*EI`'k�w ∙ L)² ®�¯ kk[°* I[I` � 'k�w ∙ L)*GI�π*EI` � SC*z±  Cez²T*  ©C*z±  Cez²ª³ 

Where 

• E  Young modulus of elasticity (E = 210000 N/mm² for steel) 

• G  shear modulus (G = 80770 N/mm² for steel) 

• kLT*L lateral torsional buckling length of the beam between points which have lateral  

restraint (= lLTB) 

• Iw  warping constant 

• It  torsional constant 

• Iz  moment of inertia about the minor axis 

• zg  distance between the point of load application and the shear center 

• kw  a factor which refers to end warping. Unless special provision for warming fixity is  

made, kw should be taken as 1,0 

• zj  z² � z�  0,5 ´ 'y² � z²) �̀C dAB   

for doubly symmetric cross-sections: z² � 0 

• zs  coordinate of the shear center 

C1, C2 and C3 are factors depending on the loading and on the end restraint conditions.  

In SCIA Engineer there are different methods implemented for the calculation of those C-factors. Those methods are 

explained further in this chapter. 

Haunched sections (I+Ivar, Iw+Plvar, Iw+Iwvar, Iw+Ivar, I+Iwvar) and composed rail sections (Iw+rail, Iwn+rail, I+rail, 

I+2PL+rail, I+PL+rail, I+2L+rail, I+Ud+rail) are considered as equivalent asymmetric I sections. 

The formula for Mcr uses the following parameters: 

• C1, C2, C3: calculated according to ENV, ECCS or Lopez 

• LTB length: kLT*L 

• k and kw: factors related to the end fixity 

• zg: load position 

• zj: asymmetry of the section 

More details about each parameter are given in separate chapters. 

It is also possible to calculate Mcr with a more precise calculation, a second order Lateral Torsional Buckling calculation 

(LTBII). This will be explained further in this chapter. 
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Calculation of C1, C2 and C3 factors 

Three C-parameters are used in the general formula for Mcr: 

• C1 takes into account the shape of the moment diagram 

• C2 takes into account the position of the loading 

• C3 takes into account the asymmetry of the cross-section 

The coefficients C1, C2 and C3 can be calculated in SCIA Engineer according to three different methods: 

• ENV 1993-1-1 Annex F 

• ECCS 119/Galea 

• Lopez, Yong, Serna 

By default, the method according to ECCS 119/Galea is applied. The following paragraphs give more information on these 

methods. 

You can choose between those 3 methods in the steel settings: 

 

 

ENV 1993-1-1 Annex F 

When this setting is chosen, the moment factors are determined according to ENV 1993-1-1 Annex F Ref.[5].  

For determining the moment factors (EN 1993-1-1: C1, C2 and C3) for lateral torsional buckling (LTB), we use the standard 

tables.  

The current moment distribution is compared with some standard moment distributions. This standard moment 

distributions are moment lines generated by a distributed q load, a nodal F load, or where the moment line reaches a 

maximum at the start or at the end of the beam. 

The standard moment distributions which is closest to the current moment distribution, is taken for the calculation of the 

factors C1, C2 and C3. 
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ECCS 119/Galea 

When this setting is chosen, the moment factors are determined according to ECCS 119 Annex B Ref.[34]. The figures 

given in this reference for C1 and C2 in case of combined loading originate from Ref.[28], which in fact also gives the 

tabulated values of those figures as well as an extended range.  

The actual moment distribution is compared with several standard moment distributions. These standard moment 

distributions are moment lines generated by a distributed q load, a nodal F load, or where the moment line is maximum 

at the start or at the end of the beam.  

The standard moment distribution which is closest to the actual moment distribution, is taken for the calculation of the 

factors C1 and C2.  

Galea gives results only for C1 and C2 factors. C3 is taken from ECCS 119 Annex B tables 63 and 64. C3 is determined 

based on the case of which the C1 value most closely matches the table value. 

 

Lopez, Yong, Serna 

When this method is chosen, the moment factors are determined according to Lopez, Yong, Serna (Ref.[35]). 

When using this method, the coefficients C2 and C3 are set to zero. 

The coefficient C1 is calculated as follows: 

C9 � �√kA9 � \S1  √kT2 A*^* � S1  √kT2 A*
A9  

Where: 

• k � �k9k* 

• A9 � VN�¶� �_�V���_�V���_·V·��_�V���_¸V�̧
'9�_��_��_·�_��_¸)VN�¶�  

• A* � ¹V��*V��eV·��V��0V¸�VN�¶ ¹ 
• α9 � 1  k* 

• α* � 5 ��·��� 

• αe � 5 º 9�� � 9��» 

• α� � 5 ��·��� 

• α9 � 1  k9 

 

With: 

• k1  taken equal to kw 

• k2  taken equal to kw 

• M1  M5 the moments My determined on the buckling system in the given sections as shown  

on the above figure. These moments are determined by dividing the beam into 10  

parts (11 sections) and interpolating between these sections.  

• Mmax maximal moment My along the LTB system 

This method is only supported in case both k and kw equal 0,50 or 1,00. 
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Comparison of the 3 calculation methods 

In below an example in SCIA Engineer in which the three methods are calculated: 

 

Example: Cfactors.esa 

In the steel settings the chosen calculation method for the C-factors has been changed. In below an overview of the 

results for those factors for the three methods: 

ENV 1993-1-1 Annex F 

 

Mcr = 1576,03 kNm 

ECCS 119/Galea 

 

Mcr = 1118,50 kNm 

Lopez, Yong, Serna 

 

Mcr = 842,64 kNm 

 

As you can see, there can be a big difference between the three calculation models. 

In the method following ‘Lopez, Yong, Serna’ the values for C2 and C3 are always taken equal to zero. 

When comparing the C1 factors, the method following ‘ECCS 119/Galea’ and ‘Lopez, Yong, Serna’ are approximately the 

same (1,26 and 1,20 respectively), but the C1 factor following the ‘ENV 1993-1-1 Annex F’ results in a total different 

value: 1,89. 

When we would calculate Mcr more detailed with a lateral torsional buckling method which takes into account second 

order behaviour, we have 1169,66 kNm as result for Mcr on element B2. So the default choice for using ECCS 119/Galea 

to calculate the C-factors makes sense. Note that lateral torsional buckling method which takes into account second 

order behaviour is only supported for SCIA Engineer 22.0 or older (32-bit!). 
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k and kw factors 

It is generally assumed that k = kw = 1, which means that the ends of the element are not fixed. If the ends are fixed, 

values lower than one can be used (usually 0,5 for full fixity or 0,7 for one end fixed and one end free) and this would 

lead to bigger values of Mcr. You can adapt the values of k and kw within the system lengths and buckling settings. 

Select the member, then open the System lengths and buckling settings window from the property panel. Select LTB 

and in Span settings you can modify the values for k and kw: 

 

When using cantilever elements, these values are automatically changed by SCIA Engineer. 

Load position 

The load position has an influence on the calculation of Mcr through the value of zg. You can choose among five load 

positions. 

If you open system lengths and buckling settings, you can see an option called Point of load application under the 

Advanced settings. The five possibilities are: 

• On top:    the load is applied on the top flange 

• In shear center:   the load is applied in the shear center 

• On bottom:   the load is applied at the bottom flange 

• Always destabilising:  the load is applied on the destabilising flange 

• Always stabilising:  the load is applied on the stabilising flange 

 

This value is set to In shear center by default and can be adapted to influence the value of Mcr. 
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LTB length 

LTB length is calculated as lLTB = kltb * LLTB 

kltb is by default taken equal to 1. A smaller value can be used to reduce the LTB length. You can adapt kltb within the 

system lengths and buckling settings: 

 

LLTB is the reference length. It is by default equal to the reference length around the weak axis (Lz) for both bottom and 

top flange. This can be seen in both previous window but as well in the steel settings window:  

 

The reference length can be overruled by another value using LTB restraints. These restraints make it possible to define 

separate conditions for bottom and top flange. 
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Dutch National Annex 

The Dutch National Annex of EN 1993-1-1 describes another formula (NB.NB.2) to calculate Mcr. M�	 � k	
@ ∙ CL± ∙ �E ∙ I` ∙ G ∙ I� 

SCIA Engineer follows this method when the Dutch National Annex is used. 

 

Example: Cfactors.esa 

Open the project and select the Dutch National Annex in the Manager for National annexes and recalculate the project. 

The steel check for beam B1 shows now the lateral torsional buckling check with Mcr calculated according to the Dutch 

National Annex. 

 

 
 

 

The Dutch National Annex also mentions conditions, which need to be fulfilled to follow this method: 

 

When one of the conditions is not fulfilled, SCIA will give a warning message (warning W30) and the default Eurocode 

method will be executed.  
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 Lateral torsional buckling check 

General case 

The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.2. M?@M�,A@ � 1 

Where: 

• M�,A@ � χ�wW, :CDE� 

• W, = W�J,, for class 1 or 2 cross-sections 

• W, = W
J,, for class 3 cross-sections 

• W, = W
::, for class 4 cross-sections 

The reduction factor LT will be calculated as follows: ¼½¾ � 9
¥¿À��¥ÁÂ� d¦§ÁÂ�    but < 1,0 

With: 

• Φ�w � 0,5©1 � α�wSλ��w  0,2T � λ��w* ª 

• λ��w � �KC:CV«�  

• Mcr critical bending moment 

• α  imperfection factor depending on the buckling curves: 

 
• with the following recommended buckling curves for lateral torsional buckling: 

 

When slenderness λ��w � 0,2 or for 
VghV«� � 0,2² lateral torsional buckling effects may be ignored. 
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Lateral torsional buckling for rolled sections or equivalent welded sections 

In the EN 1993-1-1 a distinction is made between lateral torsional buckling for general cases and for rolled sections or 

equivalent welded sections. The theory in ECCS - N° 119 clearly specifies that it is valid only for I-sections or sections 

with comparable shape. 

This distinction can also be chosen in SCIA Engineer through the steel settings and is set for all the members in the 

project: 

 

With this option, the reduction factor for lateral torsional buckling is calculated a bit differently: 

χ�w � 9
¥ÁÂ��¥ÁÂ� da¦§ÁÂ�   but χ�w � 1,0 and χ�w � 9¦§ÁÂ�  

With 

• Φ�w � 0,5©1 � α�wSλ��w  λ��w,.T � βλ��w* ª 

• λ��w,Ã= 0,4 (maximum value) 

• β= 0,75 (minimum value) 

•  

When slenderness λ��w � λ��w,Ã or for 
VghV«� � λ§LT,O² lateral torsional buckling effects may be ignored. 
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Following EN 1993-1-1 article 6.3.2.3: λ��w,Ã= 0,4 but this value can be adapted in the national annex of a country in 

SCIA Engineer (also the value for β can be changed here): 

 

The reduction factor χ�w may be modified as follows: χ�w,��@ � χ�wf  

Parameter ‘f’ may be defined in the National Annex. The following minimum values are recommended: f � 1  0,5'1  k�)+1  2,0Sλ��w  0,8T*-     but f < 1,0 

With kc by default taken from the next table: 

 

But alternatively, kc can also be calculated from the factor C1: 

k� � 1/�C9 
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In SCIA Engineer you can choose between the standard method or the calculation of kc in function of C1 (by default kc 

will be taken from Table 6.6) via the steel settings: 

 

We will demonstrate this LTB check in SCIA Engineer with following example. 

 

Example: Industrial hall.esa 

Consider beam B141. 

The default method for the calculation of the C-factors has been used. This is also indicated in the preview of the check 

results: 

First the Lateral Torsional Buckling Check will be shown: 

 

And afterwards the parameters for the calculation of Mcr will be shown. 
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Note that at the end of the output for this check, the calculation method for the C-parameters will be indicated. 

Channel sections 

When a channel section is loaded, additional torsion appears due to the eccentricity of the shear centre relative to the 

centroid of the cross-section. For that reason, the value of Mcr has to be adapted. 

To account for this additional torsion effect, the following procedure can be used where λEXTRA is calculated. 
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 LTB restraints 

 

 

In SCIA Engineer lateral torsional buckling restraints can be inputted. Those restraints will change the lateral torsional 

buckling length, used for the calculation of Mcr: 

M�	 � C9 π*EI`'k�w ∙ L)² ®�¯ kk[°* I[I` � 'k�w ∙ L)*GI�π*EI` � SC*z±  Cez²T*  ©C*z±  Cez²ª³ 

Where: 

• kLT*L: lateral torsional buckling length of the beam between points which have lateral  

restraint (= lLTB) 

This length will be taken as the distance between two LTB restraints. 

Fixed LTB restraints are defined on the top flange or on the bottom flange. The LTB lengths for the compressed flange 

are taken as distances between these restraints. The LTB moments factors are calculated between these restraints. 

The restraints can be inputted via Input panel > Steel > Steel LTB restraints or via Process toolbar > Steel > Steel LTB 

restraints. 

 

Note: only the restraints on the compressed side are taken into account. 
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Example: LTB_Restraints.esa 

In this example the same beam has been inputted three times. Since in this example an IPE450 is used, the lateral 

torsional buckling curves for Rolled section or equivalent welded are used in the steel settings: 

 

Note: the default setting for LTB curves is General case. 

The results for LC1 are: 
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B1 

 

 

 

B2 

 

 

 

 

And for beam B3, 6 LTB restraints are inputted, so no LTB calculation will be executed: 

If λ��w � λ��w,Ã or for 
VghV«� � λ��w,Ã² lateral torsional buckling effects may be ignored. With: λ��w,Ã= 0,4 

So for beam B3, the following LTB check is displayed: 
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When looking at load case LC2, the top side of the beam will be under tension, so SCIA Engineer will not take into 

account the effects of the LTB Restraints: 
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 Sheeting 

When diaphragms (steel sheeting) are used, the torsional constant It is adapted for symmetric or asymmetric I sections, 

channel sections, Z sections, cold formed U, C and Z sections. 

 

A sheeting can be inputted via Input panel > Steel > Steel sheeting or Process toolbar > Steel > Steel sheeting: 

 

The settings for the diaphragm are: 

• Sheeting LIB with this option you can choose between sheeting types of the library of 

SCIA Engineer or input his own sheeting. 

• Position z  position of the sheeting according to the LCS of the beam 

• k   value of coefficient k depends on the number of spans of the sheeting: 

k = 2 for 1 or 2 spans 

k = 4 for 3 or more spans 

• Sheeting position the position of the sheeting may be either positive or negative 

Positive means that the sheeting is assembled in a way so that the width is greater 

at the top side. 

Negative means that the sheeting is assembled in a way so that the width is greater 

at the bottom side. 

• Bolt position bolts may be located either at the top or bottom side of the sheeting 

• Bolt pitch  bolts may be either: 

in every rib (i.e. ‘br’) 

in each second rib (i.e. ‘2 br’) 

• Frame distance distance of frames 

• Sheeting length length of the sheeting (shear field) 
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The sheeting will only have an influence on the torsional constant It and will be taken into account in the calculation for 

Mcr for the lateral torsional buckling check. 

The torsional constant It is adapted with the stiffness of the sheeting. 

The value for It equals the previous value for It (thus It of the beam) plus a supplementary stiffness calculated with the 

values of the sheeting: 

I�,�@ �  I� � vorh CÈ  l²π²G 

Where: 

• 
9R�	É �Ê � 9�ÊE,Ë � 9�ÊB,� � 9�ÊÌ,Ë 

• CÈV,� � k ? �GHH�  

• CÈB,� � C9.. Í ��9..Î*     if b� � 125 

• CÈB,� � 1,25 C9.. Í ��9..Î      if 125 Ï b� Ï 200 

• CÈÐ,� Ñ e∙?∙�Ò'Éd�) 
• I� � �³9* 

With: 

• l  LTB length 

• G  shear modulus 

• vorhCθ actual rotational stiffness of the sheeting 

• CθM,k rotational stiffness of the sheeting 

• CθA,k rotational stiffness of the connection between the sheeting and the beam 

• k  numerical coefficient 

= 2 for single or two spans of the sheeting 

= 4 for 3 or more spans of the sheeting 

• EIeff bending stiffness of per unit width of the sheeting 

• s  spacing of the beam 

• ba  width of the beam flange (in mm) 

• C100 rotation coefficient – see table below 

• h  beam height 

• t  thickness beam flange 

• s  thickness beam web 
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Example: Diaphragm.esa 

Consider member B1: 

• LTB length = 7 m 

• C1 = 1,13, C2= 0,45, C3 = 0,53 

• Mcr = 281 kNm 

Consider member B2 

• It,id = 1840207 mm4 

• LTB length = 7 m 

• C1 = 1,13, C2= 0,45, C3 = 0,53 

• Mcr = 405 kNm 

The results for the calculation of the sheeting are shown in the preview of the steel check just before the section check: 
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The results for the lateral torsional buckling check are: 
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 Compression and bending check 

The compression and bending check for a member will be executed following EN 1993-1-1 art. 6.3.3. 

Unless second order analysis is carried out, members which are subjected to combined bending and axial compression 

should satisfy formulas (6.61) and (6.62): N?@χyNA�γV9
� k,, M,,?@ � ∆M,,?@χLT M,,A�γV9

� k,` M`,?@ � ∆M`,?@M`,A�γV9
� 1 

N?@χzNA�γV9
� k`, M,,?@ � ∆M,,?@χLT M,,A�γV9

� k`` M`,?@ � ∆M`,?@M`,A�γV9
� 1 

• NEd, My,Ed and Mz,Ed are the design values of the compression force and the MAXIMUM moments about 

the y-y and z-z axis along the member respectively 

Note: the word ‘MAXIMUM’ was forgotten in the translation of the Belgian National Annex. 

• Õy and Õz are the reduction factors due to flexural buckling 

• ÕLT is the reduction factor due to lateral torsional buckling 

•  

The interaction factors kyy, kyz, kzy and kzz have been derived from EN 1993-1-1 Annex A (alternative method 1) or from 

Annex B (alternative method 2).  

The choice between Interaction Method 1 or 2 can be made in the National Annex parameters: 
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Example: Industrial Hall.esa 

Consider column B28 (for combination CO1-ULS).  

In SCIA Engineer first all calculated formulas, in this example following EN 1993 Annex 1, are given and afterwards the 

check is given as two times a sum of three values as in formulas (6.61) and (6.62) of the EN 1993-1-1. 

 

 

When turning on the formulas in the detailed output, the calculation of each parameter will be shown. 
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 Shear buckling check – EN 1993-1-5 

 General 

The shear buckling check will check if the web of the cross-section can be subject to local buckling. 

This check is not included in EN 1993-1-1, but in EN 1993-1-5: Design of steel structures – Part 1-5: Plated structural 

elements. 

First, there will be checked if the value for the slenderness is smaller than a certain value, because for webs with a small 

slenderness, this check should not be executed. 

Plates with hw/t greater than 72 for an unstiffened web should be checked for resistance to shear.  

With: 

• ϵ � � *e0:CÍ �NN�Î 
• η will be defined in the National Annex. The value = 1,20is recommended for steel grades up to and 

including S460. For higher steel grades = 1,00is recommended. 

 

If the slenderness is higher than the minimum one, the shear buckling check is executed following EN 1993-1-5, formula 

(5.10) (this is a check on the shear force) and formula (7.1) (which is the check on the interaction between shear force, 

bending moment and axial force). Both formulas are checked in SCIA Engineer. 
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Example: Shear buckling.esa 

Consider Beam B1. This is an IPE160 profile: hw = 160 – 2 x 7,40 = 145,2 mm. And t = 5 mm 

• hw / t = 29,04 

This should be checked with the value: 72 = 72 x 1,00 / 1,2 = 60 

• hw / t < 72  the shear buckling check does not have to be executed. 

This is also indicated in SCIA Engineer: 

 

 

Consider Beam B2. This is an I profile: hw = 600 – 2 x 9 = 582 mm. And t = 6 mm 

• hw / t = 97 

This should be checked with the value: 72 = 72 x 1,00 / 1,2 = 60 

• hw / t > 72 

• The shear buckling check has to be executed. 
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 Stiffeners 

In EN 1993-1-5, figure 5.1 the definitions of stiffeners on a member are given: 

 

Those stiffeners will influence the total length for shear buckling. In SCIA Engineer those stiffeners can be inputted on a 

beam and will ONLY have an influence on the shear buckling check in the steel service.  

Those stiffeners can be inputted via Input panel > Steel > Steel stiffeners or Process toolbar > Steel > Steel stiffeners.  

 

 

 

The stiffeners define the field dimensions which are only relevant for the shear buckling check. When no stiffeners are 

defined, the value for buckling field length ‘a’ is taken equal to the member length. 

If you want to take stiffeners into account in the analytical model, you need to model them outside the steel service. 

You could create a new cross-section, in which the stiffener is considered, and apply that cross-section to the 1D 

member, each time over a length equal to the thickness of the stiffener. When calculating the model, the stiffener will 

be considered in the results of the deformations, stresses, … 
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Example: Stiffeners.esa 

In this example 2 identical beams are inputted. B1 without stiffeners and B2 with stiffeners: 

Let us now compare the shear buckling check with and without stiffeners: 

 

B1 - without stiffeners 

 

 

 

B2 - with stiffeners 
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Chapter 6: ULS check for battened compression members 

 

This check will be executed following EC-EN 1993-1-1 art.6.4.1 and 6.4.3. 

 

The following cross-section pairs are supported as battened compression member: 

(1) 2I 

(2) 2Uo 

(3) 2Uc 

 

 

 

You can add the links (battens) via Input panel > Steel > Links or Process toolbar > Steel > Links. 

 

The following additional checks are performed when performing the ULS check: 

• buckling resistance check around weak axis of single chord with Nf,Sd; 

• section check of single chord, using internal forces; 

• section check of single batten, using the internal forces. 

l

a

ho
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Example: EC_EN_Battened_Compression_Members_I.esa 

Consider member B1. 

On this beam, only a compression force of 500 kN is applied. 

Properties of the batten: 

 

Properties of the IPE330 cross-section: 

 

 

 

 
Values in SCIA Engineer: 
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Manual calculation of those values: 

• l  length = member length – (distance from begin) – (distance from end)  

= 5000 mm – 200 mm – 200 mm = 4600 mm 

• a  distance between battens = l / (number of divisions) = 4600 mm / 4 = 1150 mm 

• h0  distance between centroids of chords = 210 mm 

• Ich  Iz of the IPE330 profile 

• Ach  area if one I-profile, so A of IPE330 

• λ   = L / i0 = 4600 mm / 110,833 mm = 41,5 

 l9 � 0,5 ∙ h.* ∙ A�É � 2 ∙ I�É 

 � 0,5 ∙ '210 mm)* ∙ '6260 mm*) � 2 ∙ '7881000 mm�) � 1,538 x 10� mm� 

 i. � � J�*∙B«× � �9,0e� x 9.Ø���
*∙c*c.��� � 110,833 mm 

• μ  = 0 if λ > 150 

 = 2  Ù�0 if 75 < λ < 150 

 = 1,0 if λ < 75 

 for this example λ = 41,5 < 75  μ � 1,00 

• leff   � 0,5 ∙ h.* ∙ A�É � 2 ∙ μ ∙ I�É 

  � 0,5 ∙ '210 mm)² ∙ '6260 mm*) � 2 ∙ '1,00) ∙ '7881000 mm�) � 1,538 x 10� mm� 

• Sv  �  *�∙?∙��É��∙º9��∙Û«×P∙ÛÜ ∙×F� »  but Sv �  *∙��∙?∙��É��  

 n = number of planes of battens: n = 2 

 Ib = (thickness batten) x (width of batten)³ / 12 = (7 mm) x (220 mm)³ / 12  

= 6,211 x 106 mm4 

 
*�∙?∙��É��∙º9��∙Û«×P∙ÛÜ ∙×F� » � *�∙º��FFFF�NN� »∙'���9...���)

'990.��)�∙¯9� �∙'ÞØØ�FFFNN�)�∙'ß,��� ¶ �Fß NN�)∙ ��FNN��¸FNN° � 2,438 x 10� kN 

*∙��∙?∙��É�� � 
*∙��∙º��FFFF�NN� »∙'���9...���)'990.)� � 2,470 x 10� kN 

 Sv � 2,438 x 10� kN 

• e0  = l/500 = 4600 mm / 500 = 9,2 mm 

• MEd,I Mz in the cross-section under consideration = 0 kNm 

• MEd if º1  ]gh]«�  ]ghàá » & 0   M?@ �  ]gh∙
F�Vgh,M9d�gh�«� d�ghâá
 

otherwise:    MEd = 1 x 106 kNm 

 N�	 � �²∙?∙JGHH�² � �²∙º��FFFF�NN� »∙'9,0e� x 9.Ø���)
'�c..��)² � 15064 kN 

 º1  0..�]90.c��]  0..�]*��.. �]» � 0,9466 & 0 

 M?@ �  ]gh∙
F�Vgh,M9d�gh�«� d�ghâá
� 0..�]∙�,*���.�]�.,��cc � 4860 kNmm � 4,860 kNm 

• VEd � �∙VghJ � �∙��c.�]���c..�� � 3,32 kN 

The check of the chord will be executed with a section check following the EN 1993-1-1 for the chord profile with the 

following internal forces on one batten: 

 

• NG = NChord = 0,5 ∙ N?@ �  Vgh∙ÉF∙B«×*∙JGHH � 0,5 ∙ 500kN �  '��c.�]��)∙'*9.��)∙'c*c.��²)*∙9,0e� x 9.Ø��� � 270,78 kN 

• VG = VEd /2 = 3,32kN / 2 = 1,66 kN 

• MG = 
�gh∙�� � e,e*�]∙990.��� � 0,95 kNm 

This section check will result in a unity check of 0,19 
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• Nch,Ed  = NChord = 170,78 kN (see check ‘Check of chord as beam in field between battens’) 

• lcr  buckling length 

• λ  slenderness = 
J«�

� Û«ãä«ã
� 990.��

�ÞØØ�FFFNN�ß�ßFNN²
� 32,411 

• λrel relative slenderness = �B�É∙:,]«�,~ � �c*c.���∙�Þ¸�NN�9*e09... ] � 0.373 

with N�	,` � �²∙?∙�«×'J«�)² � �²∙º��FFFF�NN� »∙'���9...���)
'990.��)² � 12351 kN 

• Buckling curve = b, this is the buckling curve for the IPE330 around the z-axis 

• α  imperfection factor for buckling curve b = 0,34 

• χ  reduction factor, can be calculated as explained in the buckling check 

• UC unity check = 
]«×,gh]Ü,ih � *�.,���]9c9�,* �] � 0,16 

with N�,A@ � χ ∙  B«× ∙:CDE� � 0,94 ∙  c*c.��² ∙*�0]/��²9,.. � 1618,21 kN 

 

 

• t  thickness of batten 

• b  width of batten 

• T   � �gh ∙�ÉF∙* � e,e*�]∙990.��*9.��∙* � 9,09kN 

• MG = 0,954 kNm (see previous check) 

• σ  � Vå∙�/*�� � �0�...]��∙**.��/*c.*99∙9.ß��� � 16,9 MPa 

calculation of Ib: see calculation of Sv above 

• UC σ  = 
6HCçEF

� 9c,�VÐ��Þ¸�/NN²�,FF � 0,06 

• τ  = 
w�∙� � �.�.]**.��∙��� � 5,9 MPa 

• UC τ = 
èHC/√·çEF

� 0,�VÐ��Þ¸�/NN²/√·�,FF
� 0,04 
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Chapter 7: Optimisation 

In SCIA Engineer there are two ways of performing an optimisation: 

• cross-section optimisation: optimisation of a chosen cross-section; 

• overall optimisation: optimisation of one or more (or all) cross-sections at the same time. 

Both options are explained in the next two paragraphs. 

 Cross-section optimisation 

With this option you can optimise a cross-section for the steel code check. This will be explained in the example below. 

 

Example: Optimisation.esa 

The optimisation can be found via the steel check command. First the steel code check has to be executed, so first click 

on Refresh in the property panel. Then you can choose for the action Autodesign: 

 

It’s possible that SCIA Engineer will give following message: 

 

In the property panel the option for Filter has been changed into Cross-section. Now choose here for the cross-section 

IPE140 and click again on Refresh and afterwards on Autodesign. 

Now the Autodesign of the cross-section window will open: 

 

First you can fill in the maximal check. Normally this is a unity check of 1,00. 

The Maximum unity check displayed below is the maximum unity check for the IPE140, found in this project. 
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When clicking on <Search for optimal>, SCIA Engineer will suggest the smallest IPE cross-section which will resist the 

calculated internal forces. In this example an IPE80AA will be found. When clicking on <OK> now, SCIA Engineer will 

replace this IPE140 profile by an IPE80AA profile automatically.  

Now the steel code check of this IPE80AA profile is executed with the internal forces calculated with the properties of 

the IPE140 profile. For example, the self weight will not be taken into account correctly. So, the project should be 

recalculated, before accepting those new unity check results. 

It is also possible to use a list of sections. With this list it is possible to indicate which sections can be used or not. For 

example, the section IPE140A can be filtered out the possibilities for the autodesign. 

Recalculate the project and let us make a list for the columns. This can be done through Menu bar > Libraries > 

Structure and analysis > Cross section list and choose for Library cross-section of one type. Now select the profiles that 

should be added to this list (you can use the Ctrl button for this): 

 

When performing an Autodesign in the steel menu now for the columns HE220A, this list can be chosen: 

 

For the moment this profile has a maximum unity check of 0,01, so SCIA Engineer will search for the smallest profile 

from this ‘LIST1’ which will pass the unity check. 

Close this example without saving! It will be used in the next paragraph again! 
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In the next example the different options of the cross-section optimisation are explained. 

 

Example: Optimisation2.esa 

Go to the steel check command and execute Autodesign for this beam. 

This profile has a lot of parameters, so you can choose which parameter(s) should be updated: 

 

Also the option Advanced Autodesign will appear. With this option several parameters can be optimised at the same 

time and restriction for each parameter can be given. So input the following options: 

 

With these settings, thicknesses thb and tha are not autodesigned. If you want to autodesign these as well, the step 

should be chosen wisely (for example a step of 1 instead of 10). All other options can be adapted by SCIA Engineer.  
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When clicking on <Search for optimal>, the following profile is suggested by SCIA Engineer: 

 

With the option Set value a value for a certain parameter can be set. So, select the parameter ‘Ba’ and click on ‘Set 

value’. Now a value of 500 mm can be inputted. And the Maximum unity check for this profile will be adapted 

automatically. 

 

 Overall optimisation 

It is also possible to perform an overall optimisation in SCIA Engineer. With this option, one or more profiles can be 

optimised at the same time. Afterwards the calculation will be restarted and the internal forces are recalculated with 

the new cross-sections, followed again with a new optimisation. 

This iterative process can: 

• stop because all profiles do not have to be autodesigned and the same profile was found as in the 

previous step; 

• or stop because the maximum number of iteration steps has been reached if this is inputted by you. 

It is advised to input a number of iteration steps, otherwise this optimisation process can become a loop and will stop 

after 99 iteration steps. This will cost a lot of calculation time. 

The principle of the overall optimisation process is explained by the following example. 

 

Example: Optimisation.esa 

If this example is still open from the previous chapter, please close it and reopen it without saving. 

Calculate the project and go to Menu bar > Tools > Calculation & Mesh > Autodesign.  

Click here on Add item and choose for Steel > Cross-section AutoDesign and add all cross-sections in this autodesign 

process. 
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The combination, for which the optimisation calculation has to be calculated, can be chosen.  

Also for each profile, you can indicate if this profile has to be auto designed only in the Up direction (so only become 

bigger) or in the Up and down direction (and also can become a smaller profile as result). With this last option, there is 

a chance that the iterative process will become a loop.  

 

Now <Close> this window. And click in the next window on <Optim. Routine>: 

 

Now you can choose for a maximum number of iteration steps: 

• Determine automatically: the iteration process will stop if all the profiles are autodesigned and no 

different result will be found in a certain iteration step. So no maximum of number of iteration steps will 

be inputted. 

• Limit number of iteration: maximum of number of iteration steps. 

Input 6 iteration steps as limit number and click on <Start>. 
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Now the iteration process will start. The iteration process will stop after no difference will be found or after 6 iteration 

steps. In this example SCIA Engineer will stop after 5 iterations steps, because all cross-sections remain the same after 

the fifth step. 

After this process, an information window about this iteration will be displayed. The first two columns (Cross-section 

and Parameter) don’t provide a lot of information: they both mention the final cross-section. 

ITERATION STEP 1: 

 

Changed profiles: 

• CS1: HE220A  HE180C 

• CS2: IPE140  IPE200O 

• CS3: HFLeq45x45x5  HFLeq80x80x8 

• CS4: IPE100  IPE140AA 

ITERATION STEP 2: 

 

Changed profiles: 

• CS1: HE180C  HE140M 

• CS2: IPE200O  IPE200 

• CS3: HFLeq80x80x8  HFLeq90x90x9 

• CS4: IPE140AA  IPE140A 

ITERATION STEP 3: 

 

Changed profiles: 

• CS1: HE140M  HE140C 

ITERATION STEP 4: 

 

Changed profiles: 

• CS2: IPE200  IPE200O  
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ITERATION STEP 5: 

 

As a limit number we put 6 iteration steps, but since the cross-sections are the same as in the previous iteration step, 

the iteration process is completed after 5 iterations. 

Note that also here you can work with a list of cross-sections from which the autodesign routine can choose. 

 

 

 Arbitrary members 

Since SCIA Engineer 17.0, there is a new setting available for performing the autodesign of arbitrary members. This 

setting can be found in the steel settings. 

 

When this setting is activated (default setting), the member is considered as being prismatic (e.g.one cross-section) 

during the autodesign calculation. This speeds up the calculation. 
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Chapter 8: 2nd order calculation and imperfections 

 Overview 

Global analysis aims at determining the distribution of the internal forces and moments and the corresponding 

displacements in a structure subjected to a specified loading. 

The first important distinction that can be made between the methods of analysis is the one that separates elastic and 

plastic methods. Plastic analysis is subjected to some restrictions.  

Another important distinction is between the methods which make allowance for, and those which neglect the effects 

of the actual, displaced configuration of the structure. They are referred to respectively as second-order theory and 

first-order theory based methods.  

The second-order theory can be applied in all cases, while first-order theory may be used only when the displacement 

effects on the structural behaviour are negligible. 

The second-order effects are made up of a local or member second-order effects, referred to as the P-δ effect, and a 

global second-order effect, referred to as the P-∆ effect. 

 

On the next page an overview of the global analysis following the EN 1993-1-1, chapter 5, is given: 

• All the rules in this overview are given in the EN 1993-1-1 art. 5. For each step the rule will be indicated. 

The first rule (αcr > 10) will be explained in EN 1993-1-1 art. 5.2.1(3). 

• In this overview 3 paths are defined: 

o Path 1: in this path a first order calculation will be executed 

o Path 2: in this path a second order calculation will be executed with global (and if necessary 

local/bow) imperfections. 

o Path 3: in this path a second order calculation will be executed with the buckling shape of the 

construction as imperfection. 

• The calculation will become more precise when choosing for a higher path. 

• The lower paths will result in a faster calculation, because a first order calculation can be executed 

without iterations, but this first-order theory may be used only when the displacement effects on the 

structural behaviour are negligible. 

• In the next paragraphs the rules in this overview will be explained. 

To take into account all non-linearities in the model, non-linear load combinations are made. 
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5.2.2(3)c 

5.2.2(3)b 

5.2.2(5) 

5.2.2(7)b 

5.3.2(11) 

5.2.2(7)a 

5.2.2(3)a 

5.3.2(6) 

5.2.1(3) 

No Yes 

No Yes 

e0 if 

required 

e0 in all 

members 

Yes No 

αcr ≥ 10 

 

NEd > 25% Ncr 

(member) 

Members 

with e0 

αcr ≥ 3 

Increase sway 

effects with: 

cr
α
1

1

1

−
 

ηcr 

1b 2b 2c 3 

Global Imperfection φ 

2a 1a 

1
st
 Order Analysis 2

nd
 Order Analysis 

lb taken equal to L 

Structural Frame Stability 

Section Check 

Stability Check in plane 

Stability Check out of plane + LTB Check 

lb based on a global 

buckling mode 

 

With:  

• ηcr elastic critical buckling mode 

• L  member system length 

• lb  buckling length 
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 Alpha critical 

The calculation of alpha critical is done by a stability calculation in SCIA Engineer. 

According to EN 1993-1-1, 1st order analysis may be used for a structure, if the increase of the relevant internal forces 

or moments or any other change of structural behaviour caused by deformations can be neglected. This condition may 

be assumed to be fulfilled if the following criterion is satisfied: α�	 � é«�égh n 10 for elastic analysis 

With:  

• αcr: factor by which the design loading must be increased to cause elastic instability in  

a global mode 

• FEd:  design loading on the structure 

• Fcr: elastic critical buckling load for global instability, based on initial elastic stiffnesses 

If αcr has a value lower then 10, a 2nd order calculation needs to be executed. Depending on the type of analysis, both 

global and local imperfections need to be considered. 

EN1993-1-1 prescribes that 2nd order effects and imperfections may be accounted for both by the global analysis or 

partially by the global analysis and partially through individual stability checks of members. 

 

 Global frame imperfection φ 

 

The global frame imperfection will be inputted for the whole structure by an imperfection value . This value can be 

calculated with the following formula (EN 1993-1-1 art. 5.3.2(3)a): 

φ � 1200 ∙ αÉ ∙ α� 

With: 

• αÉ � *√É but  
*e � αÉ � 1,0 

• α� � �0,5 º1 � 9�» 

• h  height of the structure in meters 

• m number of columns in a row including only those columns which carry a vertical load  

NEd not less than 50% of the average value of the vertical load per column in the plane 

considered. 

The global imperfection can be inputted in SCIA Engineer in the nonlinear combinations as explained by the example 

below. 
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Example: Industrial Hall.esa 

In this example, two global imperfections functions will be used: one according to global X-direction and one according 

to the global Y direction. It is not necessary to combine both imperfections in the same combination.  

In SCIA Engineer you can choose to set no global imperfection (None) or you can define a Global Imperfection (here GI) 

in the nonlinear combinations (Menu bar > Libraries > Load cases, combinations > Nonlinear combinations). 

 

There are four options for the global imperfections (Menu bar > Libraries > Load cases, combinations > Global 

Imperfections): 

• Simple inclination: the imperfection is defined as a simple inclination. The inclination is defined in mm 

per m height of the structure. More specifically a horizontal displacement is given in the global X and/or 

Y direction which has a linear relation to the height (global Z direction). 

• Inclination functions: the imperfection is defined by a deformation-to-height curve, similar to the simple 

inclination. The curve can then be assigned to an appropriate non-linear combination. These inclination 

functions are entered through Initial deformations (this option is explained below) 

• Deformation from loadcase: with this option you can choose for a calculated loadcase and the 

deformation of that loadcase will be used as initial global imperfection. . This option can be used to take 

into account for example the imperfections due to the self-weight. Especially for slender beams this can 

be important. 

• Buckling shape: the imperfection is derived from the buckling data 

 

In this example the option Inclination functions has been chosen. 

These inclination functions are entered through Menu bar > Libraries > Structure and analysis > Initial deformations. 
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The Type is chosen as EN 1993-1-1 art. 5.3.2(3), with a basic imperfection of 1/200. In this way the inclination function 

is calculated according to the code EN 1993-1-1. 

The height of the construction is 8,4 m for both inclination functions.  

There are 6 columns in the X-direction, but in the middle spans only 2 columns are inputted. Because a long part of 

structure only has 2 columns in the X-direction, in this example the number of columns in this direction has been inputted 

as ‘2’. 

There are 11 columns in the Y-direction. But the columns at the end are smaller than the middle ones. So, in this 

example it is decided to input ‘9’ columns in the Y-direction.  

The inclination function for the X-direction (Def_X) in SCIA Engineer is displayed below: 
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In this example 5 nonlinear combinations are inputted: 

• 1,35 x Self Weight + 1,35 x Self Weight Cladding + 1,5 x Maintenance + 0,75 x Snow  

+ 0,9 x 3DWind10 

• 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind13 

• 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind14 

• 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind15 

• 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind16 

All combinations are entered four times: 

• NC1-NC5: inclination in the positive X-direction (GI with factor 1) 

• NC6-NC10: inclination in the negative X-direction (GI1 with factor -1) 

• NC11-NC15: inclination in the positive Y-direction (GI2 with factor 1) 

• NC16-NC20: inclination in the negative Y-direction (GI3 with factor -1) 

Tip: The nonlinear combinations can be copied from the linear combinations using the button <New from linear 

combinations>. If code or envelope combinations were used to perform the linear calculation, the linear calculation first 

needs to be executed before the nonlinear combinations can be created. 
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 Bow imperfection 

 NEd > 25% Ncr 

The relative initial local bow imperfection of members for flexural buckling is given as the value: e0/L. 

This bow imperfection does not have to be applied on each member as given in EN 1993-1-1 art. 5.3.2(6): 

 

So: 

ë̅ � �í ∙îïðñò & 0,5 �í ∙îïðóô  �B ∙:C]«� & 0,5 �B ∙:C]gh  or 
9]«� & 0,25 9]gh or õlm & 0,25 õö÷ 

So, the bow imperfection must be applied when the normal force NEd in a member is higher than 25% of the member’s 

critical load Ncr. 

 Bow imperfection e0 

The initial bow imperfection is given by: 

 

 

 

Where L is the member length. 

As explained in the previous chapter, the bow imperfection must be applied when the 

normal force NEd in a member is higher than 25% of the member’s critical buckling load 

Ncr. If NEd < 25% Ncr, you can choose to apply this bow imperfection or not. 

The buckling curve used for calculation of the imperfection is the curve inputted in the cross-section library. For standard 

sections, the curve according to the code is automatically used, for non-standard cross-sections (as general cross-

sections) you need to input the buckling curve manually. 
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Example: Industrial hall.esa 

In SCIA Engineer you can choose between three options for the bow imperfection in the nonlinear combinations: 

 

• None: no bow imperfection will be taken into account 

• Simple curvature: you will input a deformation ‘f’ or ‘1/f’ for all the members, where ‘1/f’ corresponds 

with the value ‘e0/L’ as explained earlier. 

• According to buckling data: with this option you can choose for a local imperfection as defined in the 

buckling data, so for each member following his own buckling curve (this option is explained below). 
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In this example the option According to buckling data has been chosen. 

Since SCIA Engineer 21.0 the buckling data can be defined via the steel settings: 

 

It is also possible to define the bow imperfections on buckling groups level (via Buckling groups or System lengths and 

buckling groups). 

You can choose between 6 options: 

• EN 1993-1-1 Table 5.1 – elastic: the elastic value following the buckling curve of the cross-section will 

be used 

• EN 1993-1-1 Table 5.1 – plastic: the plastic value following the buckling curve of the cross-section will 

be used 

• EN 1993-1-1 Table 5.1 – elastic – if required: the elastic value following the buckling curve of the cross-

section will be used if NEd > 25% Ncr 

• EN 1993-1-1 Table 5.1 – plastic – if required: the plastic value following the buckling curve of the cross-

section will be used if NEd > 25% Ncr 

• Manual input of bow imperfection: you can input manually a value for this bow imperfection 

• No bow imperfection: no bow imperfection is taken into account for the member 

In this example on all beams the bow imperfection EN 1993-1-1 Table 5.1 – plastic has been inputted.  
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 Buckling shape as imperfection - ηcr 

As an alternative, the global and bow imperfection can be replaced by the buckling shape as imperfection (path 3 from 

the global diagram). 

To input geometrical imperfections, the functionalities Nonlinearity > Initial imperfections and Stability must be 

activated: 

 

So first, the stability calculation (linear or nonlinear) is calculated. Afterwards in the global imperfection dialog, you can 

choose the buckling shape you want to be considered. First you can choose for the stability combination and just below 

for the calculated mode: 

 

Then you can assign this global imperfection to the desired nonlinear combination. 

The last option that must be inputted is a value for the maximum deformation. This is the deformation of the node 

which has the biggest deformation of the construction. SCIA Engineer will recalculate all the displacement of the other 

nodes using this maximal deformation. 

Since the buckling shape is dimensionless, EN 1993-1-1 gives the formula to calculate the amplitude ηinit of the 

imperfection. In the example below this calculation is given for a simple example. 
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Example: Buckling Shape.esa 

In this example, the procedure to calculate a buckling shape is illustrated for a column. 

The column has a cross-section of type IPE300, is fabricated from S 235 and has the following relevant properties: 

 

 

E = 210000 N/mm² 

fy = 235 N/mm² 

γM1 = 1,00 

L = 5000 mm 

A = 5380 mm² 

Iy = 83560000 mm4 

Iz = 6040000 mm4 

Wpl,y = 628400 mm³ 

Wpl,z = 125000 mm³ 

 

Calculation of the buckling shape 

First a stability calculation is done using a load of 1 kN. This way, the elastic critical buckling load Ncr is obtained.  

To obtain precise results, the Number of 1D elements is set to 10. This can be done via Menu bar > Tools > Calculation 

& Mesh > Mesh settings. In addition, the Shear Force Deformation is neglected so the result can be checked by a 

manual calculation. 

The stability calculation gives the following result for the critical load coefficients (Menu bar > Results > Critical load 

coefficients): 

 

This can be verified with Euler’s formula using the member length as the buckling length: 

N�	,, � π²EIøl² � π² ∙ 210000N/mm² ∙ 8,3560 ∙ 10�mm�'5000mm)² � 6927,515 kN 

For the weak axis we can calculate Ncr,z with Iz to become 500,744 kN. 
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The following picture shows the mesh nodes of the column and the corresponding buckling shape: 

    

You can ask for this result via Menu bar > Results > 3D deformations or Menu bar > Results > 1D members > 

deformations. 

Using for example an Excel worksheet, the buckling shape can be approximated by a 4th grade polynomial. 

 

A polynomial has the advantage that the second derivative can easily be calculated. 

• η�	 � 5,73 ∙ 10d9* ∙ x�  5,73 ∙ 10d� ∙ xe � 1,92 ∙ 10d0 ∙ x* � 6,20 ∙ 10d9 ∙ x 

• η�	,��x" � 6,88 ∙ 10d99 ∙ x*  3,44 ∙ 10d� ∙ x � 3,84 ∙ 10d0 

Calculation of e0 

e. � α ∙ Sλ�  0,2T ∙ MA�NA� ∙ 1  χ ∙ Sλ�T*
γV91  χ ∙ Sλ�T* � α ∙ Sλ�  0,2T ∙ MA�NA�  

With: 

• NA� � f, ∙ A � 235 ]��� ∙ 5380 mm* � 1 264 300 N 

• MA�,, � f, ∙ W�J,, � 235 ]��� ∙ 628 000 mme � 147 580 000 Nmm 'class 2) 

• MA�,` � f, ∙ W�J,` � 235 ]��� ∙ 125 000 mme � 29 375 000 Nmm 'class 2) 

• λø��� � �NA�/N�	,, � �1 264 300 N/6 927 515 N � 0,43 

• λø��� � �NA�/N�	,` � �1 264 300 N/500 744 N � 1,59 

• α � 0,21 for buckling curve a (y-y) 

• α � 0,34 for buckling curve b (z-z) 

  

y = 5,72E-12x4 - 5,72E-08x3 + 1,89E-05x2 + 6,21E-01x
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These intermediate results can be verified through SCIA Engineer when performing a steel code check on the column: 

 

 

e.,, � 0,21 ∙ '0,43  0,2) ∙ 147 580 000 Nmm1 264 300 N � p, pûü ýý 

e.,` � 0,34 ∙ '1,59  0,2) ∙ 29 375 000 Nmm1 264 300 N � þo, ü�� ýý 

Calculation of ηinit 

The required parameters have now been calculated so in the final step the amplitude of the imperfection can be 

determined. 

The section in the middle of the column is decisive  x = 2500 

• η�	 at mid section = 1000,31 

• η�	,��x"  at mid section = -3,912 ∙ 10d� ∙ 1/mm² 

• η�
��,, � e.,, ∙ ]«�,C?∙�C∙�«�,N�¶" ∙ η�	 � 5,569 mm c �*� 090 ]��FFFF�NN� ∙�e 0c. ... ���∙e,�9* ∙9.��∙ �NN� ∙ 1000 � p, û�þ ýý 

• η�
��,` � e.,` ∙ ]«�,~?∙�~∙�«�,N�¶" ∙ η�	 � 10,972 mm 0.. ��� ]��FFFF�NN� ∙c .�. ... ���∙e,�9* ∙9.��∙ �NN� ∙ 1000 � þþ, o�� ýý 

This value can now be inputted as amplitude of the buckling shape for the imperfection: 

  

NC1 (with GI and load factor 400) will lead to a unity check of 0.48 while NC2 (with GI1 and load factor 400) will lead to 

a unity check of 1.04. 
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Chapter 9: Physical non-linearity 

When the stresses are dependent on the strains in a nonlinear way, the nonlinearity is called a physical nonlinearity. 

 Plastic hinges 

When a normal linear calculation is performed and limit stress is achieved in any part of the structure, the dimension of 

critical elements must be increased. If however, plastic hinges are taken into account, the achievement of limit stress 

causes the formation of plastic hinges at appropriate joints and the calculation can continue with another iteration 

step. The stress is redistributed to other parts of the structure and better utilization of overall load bearing capacity of 

the structure is obtained. 

The material behaves linear elastic until the plastic limit is reached after which it behaves fully plastic. The σ-ε diagram 

thus has the same shape as the Moment-Curvature diagram: 

M

k

Mp

 

The full plastic moment is given as Mp, the curvature as k. 

In SCIA Engineer, a plastic moment can only occur in a mesh-node. This implies that the mesh needs to be refined if a 

plastic hinge is expected to occur at another location than the member ends. 

The reduction of the plastic moment has been implemented according to the following codes: EC3,  

DIN 18800 and NEN 6770.  

There is off course a risk when taking plastic hinges into account. If a hinge is added to the structure, the statically 

indeterminateness is reduced. If other hinges are added, it may happen that the structure becomes a mechanism. This 

would lead to a collapse of the structure and the (nonlinear) calculation is stopped. 

On the other hand, plastic hinges can be used to calculate the plastic reliability margin of the structure. The applied 

load can be increased little by little (e.g. by increasing the load case coefficients in a combination) until the structure 

collapses. This approach can be used to determine the maximum load multiple that the structure can sustain. 
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To take into account plastic hinges for steel structures, the functionality Steel > Plastic Hinge analysis must be activated 

in the functionality tab of the project settings. 

 

The choice of code which needs to be applied can be specified through Menu bar > Tools > Calculation & Mesh > Solver 

settings. The no code option simply follows the EC-EN logic. 

 

It is not possible to choose on what members or in which nodes plastic hinges can be formed. If the functionality is 

activated, a plastic hinge will form wherever the moment resistance is exceeded regardless of the element’s plastic 

capacity.  
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Example: Plastic_Hinges.esa 

In this project, a continuous beam is considered. The beam has a cross-section type IPE300 and is fabricated in S 235.  

According to Eurocode 3, the plastic moment around the y-axis is given by: 

 

For the beam (no normal or high shear force present) considered this gives the following: 

• fy = 235 N/mm² 

• Wpl,y =  6,28 105 mm³ 

• γM0 = 1,0 

 Mpl,y,d = 
KLM,C∙:CDEF  = 147,59 kNm 

A linear analysis shows the following moment-diagram: 

 

A nonlinear analysis taking into account plastic hinges gives the following result: 
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When the load is increased further, another plastic hinge will form in the middle of a span thus creating a mechanism. 

The nonlinear calculation will fail and a singularity message will be given. You can click on Detail to open an animation 

window which shows the expected scene, where an additional plastic hinge in the middle of the span leads to a 

mechanism 
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 General plastic analysis 

A general plastic analysis can be carried out for any 2D members (plates, walls and shells). The von Mises yield condition 

is currently available, which is suitable for ductile materials in general, such as metals (steel, aluminium, ...). It is a 

symmetric behaviour acting in the same way in tension and compression, with or without hardening in the plastic 

branch. 

The plastic behaviour of materials may be combined with other types of nonlinearities in SCIA Engineer.  

Note: plasticity is not supported yet for 1D members. The 1D members that are present in the model will be considered 

as elastic. 

 Von Mises yield criterion 

In SCIA Engineer, the von Mises yield criterion is implemented.  

This criterion suggests that the yielding of materials begins when the second deviatoric stress invariant J2 reaches a 

critical value. For this reason, it is sometimes called the J2-plasticity or J2 flow theory. It is part of a plasticity theory that 

applies best to ductile materials, such as metals. Prior to yield, material response is assumed to be elastic. 

In materials science and engineering the von Mises yield criterion can be also formulated in terms of the von Mises 

stress or equivalent tensile stress, σE, a scalar stress value that can be computed from the Cauchy stress tensor. In this 

case, a material is said to start yielding when its von Mises stress reaches a critical value known as the yield strength, σy. 

The von Mises stress is used to predict yielding of materials under any loading condition from results of simple uniaxial 

tensile tests. The von Mises stress satisfies the property that two stress states with equal distortion energy have equal 

von Mises stress. 

The Von Mises stress is expressed as:  

σ? � �12 ∙ +'σ99  σ**)* � 'σ**  σee)* � 'σee  σ99)* � 6 ∙ 'σ9** � σ*e* � σe9* )- 

Because the von Mises yield criterion is independent of the first stress invariant, I1, it is applicable for the analysis of 

plastic deformation for ductile materials such as metals, as the onset of yield for these materials does not depend on 

the hydrostatic component of the stress tensor, just like the Tresca criterion. 
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 Finite element model 

Drilling rotations at each node is used for in-plane loading. This means that element has six degrees of freedom at each 

node and is therefore compatible with other types of elements (beam/solid elements). 

Within the element area the Gauss 2x2 quadrature points are used. Each of these Gauss quadrature points is realized 

by nine Gauss-Lobatto quadrature points throughout the thickness, so the four-node element has 2x2x9=36 quadrature 

points in total. 

 

Due to these Gauss-Lobatto points the element can handle bending loading with high accuracy. In all of these points the 

nonlinear model is computed independently using the plane stress formulation. Linear transversal shear stiffness is 

assumed. 

 Material properties 

Figure C.2 from EN 1993-1-5 is used for the material behaviour: 

 

The different models are: 

a) elastic-plastic without strain hardening 

b) elastic-plastic with a nominal plateau slope 

c) elastic-plastic with linear strain hardening 

d) true stress-strain curve modified from the test results as follows: 

 
In SCIA Engineer, a), b) and c) are implemented.  
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 General plasticity in SCIA Engineer 

General plasticity is a specific type of nonlinearity in SCIA Engineer. This means that General plasticity is a 

subfunctionality of the nonlinear analysis. 

 

The nonlinearity of materials is defined directly in the material library. See the property group Material behaviour for 

nonlinear analysis. 

 

By default, all materials in the library are set as elastic. This means, that the selected material will behave elastically 

during a nonlinear analysis. The plastic properties of materials are generic, code independent in SCIA Engineer and are 

therefore available for any material, regardless of the selected design code. 

Plasticity can be enabled by selecting a type of plastic behaviour. For steel we can use Isotropic elasto-plastic von Mises. 

It corresponds to a bilinear stress-strain relationship, identical in tension and compression. The plastic branch may have 

a slope (hardening modulus) or not. 
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The stress-strain relationship is automatically generated from 3 parameters: Young's modulus (elastic part), yield stress 

for uniaxial tension and, optionally, hardening modulus (slope of the plastic branch). 

 

Only the tension part of the diagram is defined, as it is related to a plastification condition in general 3D stress state in 

principal stress directions. Some plastification models allow for a different yield stress in compression, which is defined 

separately. There is no limit (ultimate) strain value for the analysis.  

When the actual strain value in the structure exceeds the defined diagram, the diagram is extrapolated, tangent to the 

last defined segment of the stress-strain relationship. The reason for that is, that the analysis would then fail and it 

would be impossible to find where the problem is located in the structure. It is therefore preferable, that the analysis 

continues and that you check the obtain strain values after the analysis. 

 

The following parameters define the nonlinear behaviour of the material in the material library: 
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• E modulus: Young’s modulus of the material which defines the slope of the elastic part of the stress-strain 

diagram 

• Material behaviour: the type of material behaviour for the nonlinear analysis has to be selected 

o Elastic 

o Isotropic elasto-plastic, Tresca (ductile materials such as metal, steel, aluminium) 

o Isotropic elasto-plastic, von Mises (ductile materials such as metal, steel, aluminium) 

o Isotropic elasto-plastic, Drucker-Prager (materials with difference in compressive en tensile 

strength such as concrete and soil) 

o Isotropic elasto-plastic, Mohr-Coulomb (materials with difference in compressive en tensile 

strength such as concrete and soil) 

• Input type: defines the definition of the plastic branch of the stress-strain diagram 

o Elasto-plastic: in the plastic domain, the stress remains constant when the strain increases 

o Elasto-plastic: in the plastic domain, the stress increases with the strain 

• Yield strength: elastic limit for plastification due to shear 

• Hardening modulus: slope of the plastic branch of the stress-strain diagram 

Note: Various types of nonlinearity may be combined in the same project. However it is not possible to cumulate 

several types of nonlinearity on the same 2D member. The property FEM non-linear model will behave as follows, when 

combined with a plastic material: 

• Plastic material and 2D press-only behaviour: the press-only behaviour will be ignored and the 2D 

member will behave as plastic. 

• Plastic material and membrane behaviour: the plastic behaviour will be ignored and the 2D member will 

behave as an elastic membrane element. 

When starting the analysis, a warning message will be displayed giving the same information about functionality 

conflicts. 

 

Example: Plastic_Plate_Stresses.esa 

In this project, 3 vertical walls of different steel materials are loaded each time by the same vertical surface load of 

242,90 kN/m². The value of the load is high enough to make sure that the Von Mises stresses in every wall are higher 

than the allowed yield strength fy of the steel materials. 

A linear analysis shows the following results for the Von Mises stresses (Main menu > Results > 2D members > 

Stresses/strains): 

 

As expected, the Von Mises stresses for every wall are exactly the same and are higher than the yield strength fy. 
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For every used material, the following properties for the non-linear analysis are inserted: 

 

The nonlinear analysis shows the following results for the Von Mises stresses: 
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Example: Beam_Column_Connection.esa 

The functionality General Plasticity can also be used to model steel connections using finite elements to perform a 

plastic stress check.  

In this example, a bolted column-beam connection is modelled using 2D finite elements in SCIA Engineer. That way the 

plastic stresses can be calculated by performing a nonlinear analysis.  

Elastic results for (linear) combination CO2: 

 

Plastic results for nonlinear combination NC2: 
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Chapter 10: SLS check 

 Nodal displacement 

The nodal displacement defines the maximum global deflections in the vertical and horizontal directions.  

The following values are controlled in the example below: 

• Limit for horizontal deflections δ is h/150 

• Limit for vertical deflection δmax is L/200 

 

 

Example: Industrial Hall.esa 

Look at Menu bar > Results > Nodal displacement and look at the combination CO2 – SLS. 

Horizontal deformation 

The maximum displacement in the X direction is 26,6 mm on a height of 6,9 m. 

And in the Y-direction 27,3 mm on a height of 8,1 m. 

Limit for Limit for horizontal deflection δ is h/150 

• 6900/150 = 46 mm → 26,6 mm < 46 mm → OK 

• 8100/150 = 54 mm → 27,3 mm < 54 mm → OK 

Vertical deformation 

The maximum displacement in the Z direction is 58,7 mm 

Limit for Limit for vertical deflection δ is L/200 

• 30000/200 = 150 mm  → 58,7 mm < 150 mm → OK 
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 Relative deformation – SLS check 

To perform a steel SLS check, the following data needs to be specified: 

• the span of the elements to be checked; 

• the deflection limits of the elements to be checked; 

• the camber attributed to the elements (optional). 

The span is defined in the dialog System lengths and buckling groups. There can also overwrite the deflection limits and 

camber values of the steel setup for a certain buckling group. 

The deflection limits can be set in the Span settings part of the dialog. The deflection limits can be set independently for 

the local y and z directions (based on the active deflection option, defy or defz), and independently for total loads and 

variable loads. 

 

Three options are available: 

• For all spans: the same deflection limits will apply to all the spans of the selected element(s) 

• Per span: different deflection limits will apply to different spans 

• From setup: the deflection limits specified in the steel settings will apply to all the spans 
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The camber can be set independently for the local z and y direction (based on the active deflection option, defy or defz) 

via the combo box: 

 

Five options are available: 

• No camber: no camber will be applied 

• Design camber: the camber can be designed based on the deflection limits. You can define certain 

boundary conditions (camber shape, minimum camber, camber limit, maximum camber and rounding) 

This option is available since SCIA 19.1 

• Input camber (absolute): the camber value will be input, span by span, in absolute dimensions (length 

units) 

• Input camber (relative): the camber value will be input, span by span, as a relative coordinate (1/length 

units) 

• From setup: the camber values specified in the steel setup will be applied to all spans 

Note: The camber is defined with respect to the local z axis. If the local z axis is directed downward, you must input a 

negative value in order to have an upward camber. 

 

With the option Menu bar > Design > Steel members > SLS check or Process toolbar > Steel > Steel SLS check, the 

relative deformations can be checked. The relative deformations are given as absolute value, relative value related to 

the span, or as unity check related to the limit for the relative value to the span. 

It is also possible to visualise the camber via the SLS check. 

 

  



Chapter 10: SLS check 

BV – 2024/12/31  127 

Two options for this span are possible and explained below. 

2 nodes supported 

When two nodes are supported in this menu as shown below, the deformation is taken as the maximum deflection of 

the beam in comparison with a line connecting the two end nodes: 

 

 

In below an example of this principle: 

  

Calculation for this relative deformation: 

Deformation in the beginning of the beam = 5,967 mm and at the end = 11,863 mm. 

Maximum deformation is at 0,979 m from the beginning at the beam. 

So this point has already displaced 9,5 mm (see blue line at the picture): 

uz�J�
 J�

;.,���� � 5,967 mm � 0,979 m1,632 m ∗ '11,863 mm  5,967 mm) � 9,504 mm 

And uz, relative = 10,2 mm – 9,5 mm = 0,7 mm 

And suppose the length of this beam = 1632 m: 

rel uz � 0,73 mm1632 mm � 1/2236 
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1 node supported and the other node free (for example cantilever beams) 

This is the case if one end node is free: 

 

 

In below an example of this principle: 

    

Now the maximal relative deformation is taken as the deformation minus the deformation of the fixed node.  

And uz,relative = 12,057 mm – 0,355 mm = 11,7 mm 

And suppose the length of this beam = 1632 mm: 

rel uz � 11,7 mm1632 mm � 1/139 
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Now this principle is shown at the example of the industrial hall. 

 

Example: Industrial Hall.esa 

Consider beam B10. In the System lengths and buckling settings dialog the deflection limit for the total loads is taken as 

L/200 and for the variable loads L/360 as defined in the steel setup. 

 

 

Note: since SCIA Engineer 24.0 the output can also be displayed as relative values (L/xx) via property “Type of values = 

Overall Unity Check rel” in the property panel. 

Around the y-y axis (in the z-direction), only the first node has been supported, so the beam behaves as a cantilever and 

the deflection limit will be adapted with a factor 2. 

Length of the element = 15,075 m 

Deformation uz,max = 13,3 mm (and 0 mm at the beginning of the beam) 

 uz,max,relative = 13,3 mm – 0,0 mm = 13,3 mm 

 uz,max,relative / length = 13,3 mm / 15075 mm = 1/1129  check = 
9/99*�9/9.. � 0,09 

Deformation uz,var = 46,2 mm (and 0 mm at the beginning of the beam) 

 uz,var,relative = 46,2 mm – 0,0 mm = 46,2 mm 

 uz,max,relative / length = 46,2 mm / 15075 mm = 1/326  check = 
9/e*c9/9�. � 0,55 
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Chapter 11: Fire resistance check 

For the fire resistance calculation, a Professional or an Expert edition is necessary. The fire resistance check has been 

inputted in module sensd.05.xx (for example sensd.05.01 for the code EC-EN). 

 General 

The fire resistance check in SCIA Engineer has been inputted following the EN 1993-1-2 – simple calculation model. 

For a selected temperature curve, the temperature in the material after a required period is calculated. And with this 

material temperature, the material characteristics are adapted. 

The required levels of fire safety depend on factors such as: 

• type of occupancy; 

• height and size of the building; 

• effectiveness of fire brigade action; 

• active measures such as vents and sprinklers. 

 

 Temperature-time curves 

This is the temperature of the air during the time. 

You can choose between 4 nominal temperature-time curves in SCIA Engineer: 

 

Standard ISO 834 curve: Θ± � 20 � 345 log9.'8 t � 1) [°C] 

    α� � 25 W/m²K 

External fire curve:  Θ± � 660 '1  0,687 ed.,e* �   0,313 ede,� �) �  20 [°C] 

    α� � 25 W/m²K 

Hydroncarbon curve:  Θ± � 1080 '1  0,325 ed.,9c� �   0,675 ed*,0 �) �  20 [°C] 

    α� � 50 W/m²K 

Smoldering fire curve:  Θ± � 154√t�  �  20 [°C] 

    After 20 minutes followed by the standard ISO 834 curve 
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The temperature-time curve can be set via Menu bar > Design > Steel members > Settings > Fire resistance: 

 

 

 Steel temperature 

Afterwards, the steel temperature will be calculated after a certain time with the following formulas. This steel 

temperature will be assumed as a uniform temperature in the whole section: 

Unprotected steel member: 

Δθ�,� � k�É A�/Vc�ρ� h
 

�Δt 

Protected steel member: 

Δθ�,� � λ�A�/Vd�c�ρ�  ∙  θ±,�  θ�,�'1 � ϕ/3)Δt  ¯e �9.  1°Δθ±,� 
Where: 

• k�É correction factor for shadow effect 

 for I-sections under nominal fire actions: k�É � 0.9 ÍäN
� ÎÜÍäN
� Î  

 all other cases: k�É � +A�/V-�/+A�/V- 
•  A�/V section factor for unprotected steel members [1/m] 

 in table 4.2 (EN 1993-1-2) some section factors are calculated for unprotected steel 

members. 

•  +A�/V-� box value for the section factor 

• h


� design value on the net heat flux per unit area [W/m²] 

 this value should be obtained from EN 1991-1-2 with f = 1,0 and m = 0,7. 

• ϕ �  �L�L���� d� ∙ A�/V 

•  A�/V section factor – see also table 4.3. En 1993-1-2 
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And the netto heat flux can be calculated according EN 1991-1-2 article 3.1: 

ℎ
��� � ℎ
���,� � ℎ
���,� 

• h


�,� heat transfer by convection [W/m²] � α�SΘ±  Θ�T  

• h


�,	 heat transfer by radiation [W/m²] � Φ ∙ ε� ∙ ε: ∙ σ ∙ +'Θ	 � 273)�  'Θ� � 273)�-  

With: 

• c coefficient of heat transfer by convection [W/m²K] 

• Θ� gas temperature in the vicinity of the fire exposed member [°C] 

 this temperature may be adopted as nominal temperature-time curves as given below 

• Θ� surface temperature of the member [°C] 

•   Stephan Boltzmann constant (= 5,67 ∙ 10d� W/m²K4) 

• m surface emissivity of fire = 0,7 (EN 1993-1-2) 

• f  emissivity of fire = 1 

•   configuration factor -  = 1,0. A lower value may be chosen to take account of so  

called position and shadow effects (calculation is given in EN 1991-1-2 –Annex G). 

• Θ� effective radiation temperature of the fire environment [°C] 

 in case of fully fire engulfed members, the radiation temperature Θ� may be represented 

by the gas temperature Θ� around that member. 

The parameters of the previous formulas can be adapted in the steel settings: 
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 Steel properties 

Most of the steel properties will change by a different temperature, so once the steel temperature is known, the steel 

properties can be calculated. In below the properties for carbon steel from EN 1993-1-2, art.3 are used. The properties 

for stainless steel can be found in EN 1993-1-2 Annex C. There are also reduction factors for class 4 cross-sections 

according to table E.1 of EN 1993-1-2 Annex E. 

Reduction factors 

Effective yield strength, relative to yield strength at 20°C: k,,� � f,,�/f, 

Proportional limit, relative to yield strength at 20°C: kÐ,� � fÐ,�/f, 

Slope of linear elastic range, relative to slope at 20°C: k?,� � E�,�/E� 

 

Thermal elongation 

The relative thermal elongation of steel Δl/l should be determined from the following: 

• for 20°C � θ� Ï 750°C:  
�JJ � 1,2 x 10d0θ� � 0,4 x 10d�θ�*  2,416 x 10d� 

• for 750°C � θ� Ï 860°C:  
�JJ � 1,1 x 10d* 

• for 860°C Ï θ� � 1200°C:  
�JJ � 2 x 10d0θ�  6,2 x 10de 
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Specific heat 

The specific heat ca [J/kgK] should be determined from the following: 

• for 20°C � θ� Ï 600°C:  c� � 425 � 7,73  x 10d9 θ�   1,69 x 10deθ�* � 2,22 x 10dcθ�e 

• for 600°C � θ� Ï 735°C:  c� � 666 � 9e..*�e�d�� 

• for 735°C � θ� Ï 900°C:  c� � 545 � 9��*.
���Þ·� 

• for 900°C � θ� Ï 1200°C:  c� � 650 J/kgK 

 

Thermal conductivity 

The thermal conductivity λa [W/mK] should be determined from the following: 

• for 20°C � θ� Ï 800°C:  λ� � 54  3,33 x 10d* θ� 

• for 800°C � θ� Ï 1200°C:  λ� � 27,3  W/mK 
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 Fire resistance properties in SCIA Engineer 

In SCIA Engineer you can input fire resistance properties on a steel member via Input panel > Steel > Fire resistance 

check data or Process toolbar > Steel > Fire resistance check data: 

 

Where: 

• Required fire resistance: inputted by you as user or according to the steel setup 

• Required fire resistance R: specifies the required resistance (input) 

• Temperature-time curve: according to the steel setup or overruled for the selected member 

• Coefficient of heat transfer by convection αc: can only be changed by a user defined temperature-time 

curve 

• Modified buckling lengths during fire: the buckling ratios can be inputted manually for the fire 

resistance check 

• Fire exposure: the section may be exposed to fire on all or only three sides 

• Covered flange: when a section is exposed to fire on only three sides, the covered flange can be chosen 

here 

• Adaption factor for cross-section κ1: this parameter is the adaptation factor for non-uniform 

temperature distribution across a cross-section. This factor κ1 is used for the check on the design 

moment resistance Mfi,,Rd 

• Adaption factor for beam: at the supports of a statically indeterminate beam or all other cases 

• Adaption factor for beam κ2: this parameter is the adaptation factor for non-uniform temperature 

distribution along the beam. This factor κ2 is used for the check on the design moment resistance Mfi,,Rd 
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• Protection: yes or no 

• Insulation: here the insulation properties can be inputted 

 
• Thickness [mm]: thickness of the insulation 

 

 Calculation methods 

In SCIA Engineer 3 calculation methods are implemented: 

• resistance domain; 

• time domain; 

• temperature domain (iterative). 

The choice between those analysis types can be made in the steel settings: 
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 Resistance domain 

Principle 

You will choose the used temperature time curve and will input a required fire resistance time. After this time, the 

temperature of the gas and afterwards of the steel will be calculated. 

With this steel temperature, the reduced properties will be calculated and a fire resistance check according to EN 1993-

1-2, art. 4 will be executed with those adapted steel properties. This check will result in a unity check, which is the fire 

resistance check for the resistance domain. 

Example in SCIA Engineer 

This principle is explained with an example in SCIA Engineer. 

 

Example: Industrial hall.esa 

Consider member B28. 

Following fire resistance properties are inputted on this column: 

 

So the fire resistance will be checked after 30 minutes (= 1800 seconds) with a fibre board protection and the buckling 

factors are taken equal as the buckling factors of the normal steel code check. 
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The fire resistance check is executed via Menu bar > Design > Steel members > Fire check or Process toolbar > Steel > 

Steel ULS fire check for this column and for result class Fire (which contains combination EN-Accidental with ψ1 

coefficients and combination EN-Accidental with ψ2 coefficients), resulting in a unity check of 1,18. 

When looking at the detailed output, this calculation is given by SCIA Engineer (it is also possible to turn on the formulas 

as for the normal ULS checks). 

First, the partial safety factors are given: 

 

Then the material properties (not adapted by the temperature) are given: 

 

And the fire resistance properties as inputted in SCIA Engineer. Here is also indicated that the fire resistance check has 

been executed after 30 minutes of fire. 
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Now a graph is shown with the gas temperature (in this example follow the ISO 834 curve), the steel temperature 

calculated with a protection and the reduction of the yield strength. 

 

And then the unity checks are shown with the reduced properties: 
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So in this example the Bending and axial compression check will result in a unity check of 1,18. 

To reach the required fire resistance of 30 minutes, you could increase the thickness of the insulation (for example to 6 

mm or more). 
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 Time domain 

Principle 

You will choose the used temperature time curve and will input a required fire resistance time. After this time, the 

temperature of the gas and afterwards of the steel will be calculated. 

Now also the critical steel temperature will be calculated. The fire resistance check according to the time domain will be 

the ratio of the real steel temperature after a chosen time and the critical steel temperature. 

This critical steel temperature a,cr will be calculated with a simple formula: 

θ�,�	 � 39,19 ln \ 10,9674 μ.e,�ee  1^ � 482 

Where 0 is the degree of utilization. This means the unity check following EN 1993-1-2 at time = 0 sec, so without 

augmentation of the temperature. 

Note: this simple formula is only valid if no stability phenomena or deformation criteria have to be taken into account! 

Therefore, this calculation method will rarely be used. 

Example in SCIA Engineer 

This principle is explained with an example in SCIA Engineer. 

 

Example: Industrial hall.esa 

Consider member B28. 

Change in the steel settings the analysis type to Time domain. 

The fire resistance check is executed via Menu bar > Design > Steel members > Fire check or Process toolbar > Steel > 

Steel ULS fire check for this column and for result class Fire, resulting in a unity check of 0,46. 

When looking at the detailed output, following information is mentioned by SCIA Engineer: 

 

So the check following EN 1993-1-2 will be executed at t = 0 min, so at 20°C, without any reduction of the steel 

properties. This check will result in a low unity check, which is the degree of utilisation μ0. 

In this example again the ‘Bending and axial compression’ check will result in the highest unity check = 0,46 =μ0. 

 

This value is used in the simple formula for the critical steel temperature: 
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θ�,�	 � 39,19 ln \ 10,9674 μ.e,�ee  1^ � 482 � 39,19 ln � 10,9674 '0,46)e,�ee  1� � 482 � 596,41 °C 

And the steel temperature after 30 minutes is 600,06°C.  

The unity check is: 
c..,.c°�0�c,�9°� � 1,01 

All those values are also given in the overview table in the preview of the fire resistance check: 

 

Also the fire resistance time is given in this table: this member can resist fire for 29,65 minutes. 

 

Note: as stated before, this simple calculation method can only be used if no stability phenomena have to be taken into 

account. In this example the stability causes the highest unity check and is thus taken into account, so this method is 

not correct and should not be used! 
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 Temperature domain (iterative) 

Principle 

If this method is used, the critical steel temperature will be calculated with an iterative process. So first, an estimation 

of this critical temperature will be chosen and the unity check following EN 1993-1-2 will be executed, if this check is 

lower than one, a higher critical temperature is chosen or when this check is higher than one, a lower temperature is 

chosen. Now this unity check is recalculated just until the moment this unity check gives a result for this critical steel 

temperature between 0,99 and 1. 

This is a more accurate procedure to calculate the critical temperature and this method is also valid if stability 

phenomena or deformation criteria have to be taken into account. 

Example in SCIA Engineer 

This principle is explained with an example in SCIA Engineer. 

 

Example: Industrial hall.esa 

Consider member B28. 

Change in the steel settings the analysis type to Temperature domain (iterative). 

Change in the steel settings the analysis type to Time domain. 

The fire resistance check is executed via Menu bar > Design > Steel members > Fire check or Process toolbar > Steel > 

Steel ULS fire check for this column and for result class Fire, resulting in a unity check of 0,80. 

When looking at the detailed output, following information is mentioned by SCIA Engineer: 

 

So the check following EN 1993-1-2 will be given at a,cr = 832,40 °C. This temperature is calculated iteratively resulting 

in a unity check following the EN 1993-1-2 equal to 1,00: 

 

And indeed the highest unity check will be equal to 1,00 for this critical temperature.  

So for this case the unity check is: 
c..,.c°��e*,�.°� � 0,72 
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All those values are also given in the overview table in the preview of the fire resistance check: 

 

And also the fire resistance time is given in this table: this member can resist fire for 70,57 minutes. 
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Annex A: Shear areas 
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Annex B: Examples on the Eurocode paths 

This annex will illustrate the Eurocode paths with some examples. Path 2b is not given since this path cannot be used in 

practice: or you put a local imperfection on all members as in path 2c or you put no local imperfections as in path 2a. It 

is possible to put a local imperfection on several members, but the flexural buckling check will always be performed on 

all members or no member at all. 

Example project: 1 load case, containing 3 point loads of 500 kN and a wind load case with load 70 kN/m on the left 

column. For the examples of paths 1b, 2a, 2c and 3, the loads are increased to 750 kN to have a lower critical alpha 

coefficient. 
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Path 1a: 1st order analysis 

Functionalities 

 

 

Stability calculation 

We perform a stability analysis to check if the critical alpha coefficient is bigger than 10. If so, it is sufficient to perform a 

first-order analysis. As mentioned in the chapter ‘Buckling shape as imperfection’, the Average number of tiles of 1d 

element is set to 10: 

 

Via Menu bar > Results > Critical load coefficients, a critical alpha coefficient of 14,08 is found, so it is sufficient to 

perform a first-order analysis. 
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Linear calculation 

Setup of buckling properties: 

• buckling factor k: calculated by default by SCIA Engineer (only valid for simple structures!); 

• sway/non-sway property: proposition of SCIA Engineer to be checked by you as user; 

• system length of member: proposition of SCIA Engineer to be checked by you as user. 

Alternative: manual input of the buckling factor k or the buckling length l 

We perform the ULS check on combination CO1: the unity check for flexural buckling is decisive. 
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Nonlinear calculation 

Same setup of buckling properties as for linear calculation. 

The only difference is the Tension only property (via Input panel > Structure > Boundary conditions > Nonlinearity 1D) 

that has been added to the wind bracings. This means we are still dealing with a 1st order calculation, but a nonlinear 

calculation must be executed to take the local nonlinearity ‘tension only’ into account. 

Attention: It is necessary to execute both linear and nonlinear calculation/analysis, because the buckling properties are 

calculated only during the linear calculation!.  

 

We perform the ULS check on nonlinear combination NC1: the unity check for flexural buckling check is still decisive. 
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Path 1b: 1st order analysis 

Functionalities 

 

 

Stability calculation 

The stability calculation will be performed to determine the critical alpha coefficient. As mentioned in the chapter 

‘Buckling shape as imperfection’, the Average number of tiles of 1d element is set to 10.  

The critical alpha value must be higher than 3 to be able to use path 1b of the structural frame stability scheme. In this 

example, the critical load coefficient is equal to 9,55 (which is in between 3 and 10). 
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Linear combination 

First you can check if condition EN1993-1-1 5.3.2 (4) is fulfilled or not. 

 

If the wind load would be small than 15% of the vertical load, you need to take into account the effect of a global 

imperfection, e.g. via equivalent horizontal forces. In our example this isn’t necessary. 

The Amplified Sway Moment method may only be used, if the actual normal force NEd is smaller than 25% of the critical 

Euler force Ncr. Both values are printed in the detailed output of the steel code check. For column S1: 

 

 

Next the Amplified Sway Moment Method can be activated in the linear combinations and the critical alpha value has to 

be inserted: 

 

We only consider the amplification factor on the wind load case. The coefficient of initially 1,5 increases to 1,68 due to 

the amplification factor of 1,12. 
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Linear calculation 

The buckling lengths are taken equal to the system lengths. This can be done via ‘System lengths and buckling settings’ 

for y-y and z-z: 

 

In the next step, the linear analysis can be performed. Since the global imperfections are inserted in the nonlinear 

combination, the linear as well as the nonlinear calculation need to be performed. 

We perform the ULS check for combination CO1: the unity check for combined compression and bending is decisive. 

 

 

Note: you could also calculate nonlinear with a global imperfection, but then you should adapt the coefficients in the 

nonlinear combination to take into account the amplification factor. But  path 2a te gaan 
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Path 2a: 2nd order analysis – global imperfection 

Functionalities 

 

Stability calculation 

The stability calculation will be performed to determine the critical alpha coefficient. Since the critical alpha value is 

smaller than 10, we cannot follow path 1a of the Eurocode overview so we could follow path 2a. 

 

Global imperfection: 

The next step is to insert the global imperfection. This will be done using ‘Main menu > Libraries > Structure and 

analysis > Initial deformations’. 

Since this example is made in a 2D-environment, one initial deformation for the X-direction is sufficient. If the project 

was made in a 3D-environment, it would be needed to create two initial deformations (one in X-direction and one in Y-

direction). 
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You can create two global imperfections (Main menu > Libraries > Load cases, combinations > Global Imperfections), 

one for X in positive direction and one for X in negative direction (factor -1): 

 

These global imperfections can now be chosen into the nonlinear combinations. 
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Steel setup 

The whole structure can be considered as non-sway, which means that l ≤ L (or conservatively l = L). SCIA Engineer will 

execute the flexural buckling check with k = 1. 

 

We perform the ULS check for the result class ‘RC NL’: the unity check for combined compression and bending is 

decisive. 
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Path 2c: 2nd order analysis – global + local imperfection 

Functionalities 

 

 

Stability calculation 

The stability calculation will be performed to determine the critical alpha coefficient. Since the critical alpha value is 

smaller than 10, we cannot follow path 1a of the Eurocode overview so we could follow path 2c. 

 

Global imperfection: see previous chapter. 
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Bow imperfection 

The bow imperfection e0 is inserted in the System lengths and buckling groups (or you can set it for the entire project 

via the steel settings and put the diagonals manually to No bow imperfection via the System lengths and buckling 

settings): 

 

 

And in the nonlinear combination, a reference is made to this inserted buckling data: 
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Steel setup 

According to the Eurocode, it is not necessary anymore to execute the flexural buckling check. 

SCIA Engineer will execute the flexural buckling check with k = 0,001, so that it will not be decisive. 

 

 

We perform the ULS check for the result class ‘RC NL’: the section check for combined bending, axial force and shear 

force is decisive (unity check for combined compression and bending is 1,66 for the left column). 
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Path 3: 2nd order analysis – buckling shape as imperfection 

Functionalities 

 

 

Stability calculation: see previous chapters. 

The first buckling mode looks like this: 
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Calculation of ηinit  to be filled in as ‘max. deformation’ (see ‘Global Imperfection’ dialog) 

 

 

Steel setup 

According to the Eurocode, it is not necessary anymore to execute the flexural buckling check. 

SCIA Engineer will execute the flexural buckling check with k = 0,001, so that it will not be decisive. 

 

 

  



Advanced Concept Training – Steel code check 

164  BV – 2024/12/31 

We perform the ULS check for the result class ‘RC NL’: the section check for combined bending, axial force and shear 

force is decisive (unity check for combined compression and bending is 1,44 for the left column). 
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